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Introduction: 

The educational program is a well—planned set of courses that include procedures and 

experiences arranged in the form of an academic syllabus. Its main goal is to improve and build 

graduates' skills so they are ready for the job market. The program is reviewed and evaluated 

every year through internal or external audit procedures and programs like the External 

Examiner Program. 

The academic program description is a short summary of the main features of the 

program and its courses. It shows what skills students are working to develop based on the 

program's goals. This description is very important because it is the main part of getting the 

program accredited, and it is written by the teaching staff together under the supervision of 

scientific committees in the scientific departments. 

This guide, in its second version, includes a description of the academic program after 

updating the subjects and paragraphs of the previous guide in light of the updates and 

developments of the educational system in Iraq, which included the description of the academic 

program in its traditional form (annual, quarterly), as well as the adoption of the academic 

program description circulated according to the letter of the Department of Studies T 3/2906 

on 3/5/2023 regarding the programs that adopt the Bologna Process as the basis for their 

work. 
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Concepts and terminology: 

 Academic Program Description: The academic program description provides a brief 

summary of its vision, mission and objectives, including an accurate description of the 

targeted learning outcomes according to specific learning strategies. 

Course Description: Provides a brief summary of the most important characteristics 

of the course and the learning outcomes expected of the students to achieve, 

proving whether they have made the most of the available learning opportunities. It 

is derived from the program description. 

Program Vision: An ambitious picture for the future of the academic program to be 

sophisticated, inspiring, stimulating, realistic and applicable. 

Program Mission: Briefly outlines the objectives and activities necessary to achieve 

them and defines the program's development paths and directions. 

Program Objectives: They are statements that describe what the academic 

program intends to achieve within a specific period of time and are measurable and 

observable. 

Curriculum Structure: All courses / subjects included in the academic program 

according to the approved learning system (quarterly, annual, Bologna Process) 

whether it is a requirement (ministry, university, college and scientific department) 

with the number of credit hours. 

Learning Outcomes: A compatible set of knowledge, skills and values acquired 

by students after the successful completion of the academic program and must 

determine the learning outcomes of each course in a way that achieves the 

objectives of the program. 

Teaching and learning strategies: They are the strategies used by the faculty 

members to develop students' teaching and learning, and they are plans that are 

followed to reach the learning goals. They describe all classroom and extra— 

curricular activities to achieve the learning outcomes of the program. 
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Concepts and terminology:  

Academic Program Description: The academic program description provides a brief 
summary of its vision, mission and objectives, including an accurate description of the 
targeted learning outcomes according to specific learning strategies.  

Course Description: Provides a brief summary of the most important characteristics of the 
course and the learning outcomes expected of the students to achieve, proving whether 
they have made the most of the available learning opportunities. It is derived from the 
program description. 
Program Vision: An ambitious picture for the future of the academic program to be 
sophisticated, inspiring, stimulating, realistic and applicable. 
Program Mission: Briefly outlines the objectives and activities necessary to achieve them 
and defines the program's development paths and directions.  

Program Objectives: They are statements that describe what the academic program 
intends to achieve within a specific period of time and are measurable and observable. 
Curriculum Structure: All courses / subjects included in the academic program according to 
the approved learning system (quarterly, annual, Bologna Process) whether it is a 
requirement (ministry, university, college and scientific department) with the number of 
credit hours. 
Learning Outcomes: A compatible set of knowledge, skills and values acquired by students 
after the successful completion of the academic program and must determine the learning 
outcomes of each course in a way that achieves the objectives of the program. 
Teaching and learning strategies: They are the strategies used by the faculty members to 
develop students’ teaching and learning, and they are plans that are followed to reach the 
learning goals. They describe all classroom and extra- curricular activities to achieve the 
learning outcomes of the program.  
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1. Program Vision  

The Department of Mathematics aspires to gain global recognition in the fields of scientific research 
and teaching by achieving academic quality, as well as local recognition in the field of supplying the 
labor market with highly qualified scientific personnel.  

 

 

2. Program Mission  

Raising the efficiency of mathematicians and mathematical sciences in society and supporting various 
science specializations with high-level graduates to effectively contribute to the scientific renaissance 
and developing ways that would build qualified athletes at the highest level in teaching and training to 
contribute to raising the level of mathematical thought among trainees  

 

 

3. Program Objectives  

1. Providing students with the knowledge and learning of modern principles and methods in the study 
of mathematics. 
2. Introducing students to the importance of mathematics. 
3. Graduating an elite group of students who have the ability to continue graduate studies to support 
higher education in the future  

 

 

4. Program Accreditation  

Does the program have program accreditation? And from which agency? Yes, the program has 

program accreditation from the National Council for Accreditation of Programs of Colleges of the 
Educational Group  

 

 

5. Other external influences  

Is there a sponsor for the program? Ministry of Higher Education and Scientific Research, Scientific 
Supervision and Scientific Evaluation Apparatus, Directorate of Quality Assurance and Academic 
Accreditation, Accreditation Department.  

 

 

6 Program Structure 

Institution Requirements Number of Courses Credit hours Percentage Reviews• 

College Requirements 36 162 %100 
 

College Requirements     

Department Requirements     

Summer Training - - -  

Other 

 

 

 

 

There is field training 

in high schools 
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7. Program Description 

First Year 

Course Name Course Code 
Credit Hours 

Units 
Theoretical practical 

Calculus - 3 2 8 

Foundations of Mathematics - 2 2 6 

Linear Algebra - 2 2 6 

General Physics - 2 - 4 

Computer Science - 1 - 2 

Foundations of Education - 2 - 4 

Educational Psychology - 2 - 4 

Arabic Language - 1 - 2 

English Language - 1 - 2 

Human rights and democracy - 1 - 2 

Total 17 6 40 

 

 

 

 

Second Year 

Course Name Course Code 
Credit Hours 

Units 
Theoretical practical 

Advanced Calculus - 3 2 8 

Group Theory - 2 1 5 

Ordinary Differential Equation - 2 2 6 

Geometry and Axiomatic Systems - 2 1 5 

Computer Science - - 2 2 

Administration and Supervision - 2 - 4 

Developmental Psychology - 2 - 4 

English Language - 1 - 2 

Baath Party Crimes - 1 - 2 

Total 15 8 38 
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Third year 

Course Name Course Code 
Credit Hours 

Units 
Theoretical practical 

Mathematical Analysis - 2 2 6 

Numerical Analysis - 2 2 6 

Probability - 2 2 6 

Rings - 2 2 6 

Partial Differential Equations - 2 1 5 

Philosophy of Scientific Research - 2 - 4 

Curricula and Teaching Method - 1 2 4 

Educational Guidance - 2 - 4 

English Language - 1 - 2 

Total 16 11 43 

 

 

Forth  year 

Course Name Course Code 
Credit Hours 

Units 
Theoretical practical 

Topology - 2 2 6 

Mathematical Statistics - 2 2 6 

Complex Analysis - 2 2 6 

Operations Research - 2 2 6 

Graph Theory - 2 2 6 

Graduation Research Work - - 2 2 

Measuring and Amendment - - 2 4 

English Language - 1 - 2 

Professional ethics - 1 - 2 

Practical Teaching  1 2 4 

Total 15 14 44 
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         8. Expected learning outcomes of the program  
Knowledge  
A1- Enabling the student to gain an understanding 
of mathematics. 
A2- Preparing qualified teachers to teach in 
educational institutions.  

A3- Preparing a high-quality mathematics teacher. 

 

Skills  
B1 - That the student acquires the skill of 
mathematical operations. 
B2 - That the student acquires skills in methods of 
proof and thinking.  

B3 - The student should be able to link the 
information.  

1. The correct scientific thinking method. 2. 
Discussion method. 
3. Daily, monthly and annual tests.  

 

C1- The method of discussion and dialogue 
between the student and the professor. 
C2- Conclusion. 
C3- Mathematical logic  

1. Through daily and monthly tests. 
2. Discussions. 
3. Practical and applied tests. 
4. By reviewing the experiences of different 
universities.  

Ethics  
D1- Utilizing the acquired information. 
D2- Personal development through reading and 
updating knowledge. 
D3- Engaging in the teaching profession. 
D4- Participation in seminars, conferences and 
workshops Specialized.  

 

 

 

9. Teaching and Learning Strategies  
Theoretical and practical teaching of mathematics sciences, as well as graduation research and 
others.  

  
 

10. Evaluation methods  
1. Theoretical and practical tests.  

2. Discussions. 
3. Final exams.  
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11. Faculty 
Faculty Members 

Academic Rank 

Specialization Special 
Requireme
nts/Skills 

(if 
applicable 

Number of the 
teaching staff 

General Special Staff Lecturer 

Prof. Dr Rana bahjat yaseen Mathematics  Topology    √  
Assist. Prof. Dr Israa Munir Tawfik Mathematics  Topology   √  
Assist. Prof. Dr Mohammad Abd moheemmeed Mathematics  Numerical Analysis    √  
Assist. Prof. Dr. Amer fadhel  nassar Mathematics  Applied mathematics   √  
 Prof. Nihad Shareef Khalaf Mathematics  Time series   √  
Assist. Prof. Elaf Sabah Abdulwahid Mathematics  Functional analysis   √  
Assist. Prof. Dr.Sarwa Abd-Alqader Physics   solid physics   √  
Assist. Prof. Hiba omer mousa Mathematics  Topology   √  
Assist. Prof. Dr Sondos Nouri Shukr Mathematics  Methods of Teaching    √  
Ass.Lecturer Dr Heba Hani Abdullah Mathematics  Time series   √  
Lecturer. Zeina Taha Abdel Qader Mathematics  Topology   √  
Lecturer Nada Jassim Mohammed Mathematics  Algebra   √  
Lecturer. Kholoud Gamal Mouloud Computer  Computer   √  
Lecturer Asmaa Saleh Qaddouri Mathematics  Statistics   √  
Lecturer Fadia Abdel Fattah Habib Computer  Computer   √  
Assist. Lect. Muhammad Muayyad Sultan Computer  Computer   √  
Assist. Lect. Raghad Wameed Fares Mathematics  Statistics   √  
Assist. Lect. Farah Amer Abdulaziz Computer  Computer   √  
Assist. Lect. Faten Haitham Mouloud Physics Physics   √  

 

  
 

Professional Development 

Mentoring new faculty members 

New faculty members were directed to complete a teaching suitability test and entered training 
courses and workshops to develop their skills in teaching and scientific research.  

 

Professional development of faculty members 

Introducing faculty members into training courses and workshops to develop their skills in teaching 
and scientific research. . 



1
0 

 

 
 

 
 
 
 
 
 

12. Acceptance Criterion 

(1- Central admission. 
2- Scientific interview. 
3- The graduate of the preparatory stage is accepted exclusively in the scientific stream 
(biology - applied). 
4- Medical examination. 

 

13. The most important sources of information about the program 

1- Sources approved by the university (sectoral committee). 2- External sources and various 
books. 
3- The Internet. 

14. Program Development Plan  
1- Many duties that require external information. 2- Many practical applications.  

 



 

 
 

 
 Required program Learning outcomes 

Year/
Level 

Cours
e 
Code 

Course Name 

 

   

A1 A2 A3 A4 B1 B2 B3 B4 C1 C2 C3 C4 

F
ir

st
 Y

ea
r 

 

 Calculus Basic  √ √ √  √ √ √  √ √ √ √ 

 Foundations of Mathematics Basic  √ √ √  √ √ √  √ √ √ √ 

 Linear Algebra Basic  √ √ √  √ √ √  √ √ √ √ 
 General Physics Basic  √ √ √  √ √ √  √ √ √ √ 
 Computer Science Basic  √ √ √  √ √ √  √ √ √ √ 
 Foundations of Education Basic  √ √ √  √ √ √  √ √ √ √ 
 Educational Psychology Basic  √ √ √  √ √ √  √ √ √ √ 
 Arabic Language Basic  √ √ √  √ √ √  √ √ √ √ 
 English Language Basic  √ √ √  √ √ √  √ √ √ √ 
 Human rights and democracy Basic  √ √ √  √ √ √  √ √ √ √ 

  

S
ec

o
n
d
 Y

ea
r 

 

 Advanced Calculus Basic  √ √ √  √ √ √  √ √ √ √ 

 Group Theory Basic  √ √ √  √ √ √  √ √ √ √ 

 Ordinary Differential 
Equation 

Basic  √ √ √  √ √ √  √ √ √ √ 

 Geometry and Axiomatic 
Systems 

Basic  √ √ √  √ √ √  √ √ √ √ 

 Computer Science Basic  √ √ √  √ √ √  √ √ √ √ 

 Administration and 
Supervision 

Basic  √ √ √  √ √ √  √ √ √ √ 

 Developmental Psychology Basic  √ √ √  √ √ √  √ √ √ √ 

 English Language Basic  √ √ √  √ √ √  √ √ √ √ 

 Baath Party Crimes Basic  √ √ √  √ √ √  √ √ √ √ 

 
 
 



 

 
 
 

 

 

y
ea

r.
 

 

 Mathematical Analysis Basic  √ √ √  √ √ √  √ √ √ √ 

 Numerical Analysis Basic  √ √ √  √ √ √  √ √ √ √ 

 Probability Basic  √ √ √  √ √ √  √ √ √ √ 

 Rings Basic  √ √ √  √ √ √  √ √ √ √ 

 Partial Differential Equations Basic  √ √ √  √ √ √  √ √ √ √ 

 Philosophy of Scientific 
Research 

Basic  √ √ √  √ √ √  √ √ √ √ 

 Curricula and Teaching 
Method 

Basic  √ √ √  √ √ √  √ √ √ √ 

 Educational Guidance Basic  √ √ √  √ √ √  √ √ √ √ 

 English Language Basic  √ √ √  √ √ √  √ √ √ √ 

 

F
o
rt

h
 y

ea
r 

 

 Topology Basic  √ √ √  √ √ √  √ √ √ √ 

 Mathematical Statistics Basic  √ √ √  √ √ √  √ √ √ √ 

 Complex Analysis Basic  √ √ √  √ √ √  √ √ √ √ 

 fuzzy optional  √ √ √  √ √ √  √ √ √ √ 

 Functional analysis optional  √ √ √  √ √ √  √ √ √ √ 

 Graduation Research Work Basic  √ √ √  √ √ √  √ √ √ √ 

 Measuring and Amendment Basic  √ √ √  √ √ √  √ √ √ √ 

 English Language Basic  √ √ √  √ √ √  √ √ √ √ 

 Professional ethics Basic  √ √ √  √ √ √  √ √ √ √ 
 

 Practical Teaching Basic  √ √ √  √ √ √  √ √ √ √ 
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Course Description Form 
 

Course Name:  

        Topology 

Course Code: 

 

Semester / Year:  

         2024-2025  

Description Preparation Date: 

            2024-9-18 

5. Available Attendance Forms: 

 

6. Number of Credit Hours (Total) / Number of Units (Total) 

         4 Hours  

7. Course administrator's name (mention all, if more than one name) 

Name : Rana Bahjat Yaseen  

Email : zain2016@tu.edu.iq 

 

 

 

 
- Study and knowledge of topological spaces 
- Study types of continuous functions 
- Study the concept of connoted and compact   

 

∙ 

 

 
Applying various teaching methods ,including  

- Giving lectures  
Discussion method and electronic method. 

mailto:zain2016@tu.edu.iq
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4-1 12 Topological spaces  Open set ,closed set, 

Bases and subbases    

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

8-5 12 Topological spaces Interior , exterior 

,boundary, closure 

of a set   

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

9-12  12  Connectedness   Separated sets , 

connected sets, 

locally connected  

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

13-16  12 Continuity  and 

topological 

equivalence   

Continuous 

functions , open and 

closed and 

homeomorphism 

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

17-20 12 Compactness  Covers ,compact 

sets , locally 

compact 

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

21-25 15 Separation axioms  T1 –space , T2- 

space, regular space 

and normal space   

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 
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Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 

 

                                                                                           General Topolgy  Seymour lipschutz 

                                                                                            Topology and maps by T. Husain 1977 

                                                                                                 Introduced of  Topology 

                                                                                                          Shawm series 
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Course Name:  

   Time series 

Course Code: 

 

Semester / Year: 2025/2024 

      2024-2025  

Description Preparation Date: 18/9/2024 

             2024-9-18 

5. Available Attendance Forms: 
 

6. Number of Credit Hours (Total) 30 / Number of Units (Total) 8 

   4 Hours 

7. Course administrator's name (mention all, if more than one name) 

Name: Nihad Shareef Khalaf 
 Email: nihad.shreef16@tu.edu.iq 

 

 

 
- Study and knowledge of time series and types 

of models in linear time series  

- Study concept of stationary and what is 

dependent 

Study spectral density function and perdiction 



 

 
Applying various teaching methods ,including  

- Giving lectures  

Discussion method and electronic method. 

 

 
 

 
 

 
 

  

 
 
 

 
  

1-4 16  Random variable 

,stochastic 

processes ,time 

series with 

examples ,first and 

second order and 

complete stationary 

process  

,autocovariance and 

autocorrelation 

function  

Stationary 

stochastic processes    

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

mailto:nihad.shreef16@tu.edu.iq
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5-6 8 White noise process 

and autoregressive 

models of orders 1&2 

Standard discrete 

random models   
Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

7-11 16 autoregressive models 

of orders p 

AR(P),moving average 

models MA(q), mixed 

ARMA(P,q) models 

Standard discrete 
random models   

Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

12-17 24 The general linear 

model and Harmonic 

process  

Standard discrete 

random models   
Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

18-20 8 White noise process 

and autoregressive 

models of orders 1&2 

Standard continuity 

random models   
Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

20-23 12 
autoregressive models 

of orders p AR(P) and 

moving average models 

MA(q) 

Standard continuity 

random models   
Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 

24-30 24 
Fourier function and 

spectral analysis of 

periodic function  and 

non -periodic function , 

spectral analysis of 

stationary process, 

relationship between 

spectral analysis and 

autocovariance and 

spectral analysis of 

time series 
Electronic 

lectures, 

smart board 

,pen   

Written and 

daily exams 

with 

assignments 
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autocorrelation 

function  

  Find prediction 

by Kolomogrov 

approach in 

linear prediction 

and how find 

the value in 

future  

Prediction  Electronic 
lectures, smart 
board ,pen   

Written and 
daily exams 
with 
assignments 

 

 

 
 
 

Applications  

Complex functions for the third grade of physics 
 

A First Course in Complex Analysis with Applications (2003), Dennis G. Zill and Patrick D. 

Shanahan, Jones and Bartlett Publishers, London. 

 

 

 

Distributing the score out of 100 according to the tasks assigned to the student such as 
daily preparation, daily oral, monthly, or written exams, reports etc 
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 Course 

Description Form 
 

Course Name: Complex analysis 

 

Course Code: 

 

Semester / Year: 2024/2025 

 

Description Preparation Date: 18/9/2024 

 

5. Available Attendance Forms: 
 

6. Number of Credit Hours (Total) 30 / Number of Units (Total) 8 

 

7. Course administrator's name (mention all, if more than one name) 

Name: Assist. Prof. Dr. Mohammad Sabawi 
 Email: mohammad.sabawi@tu.edu.iq 

 

 

 
For many of our students, complex analysis 
is their first rigorous analysis (if not 
mathematics) class they take, and these 
topics reflect this very much. We tried to rely 
on as few concepts from real analysis as 
possible. The complex numbers have many 
nice properties which make us think a lot 
how to show that the complex numbers are 
set up in order to explore the properties of 
the complex numbers, since these properties 
will be both algebraic properties (such as 
commutative and distributive properties) for 
example, that multiplication can be described 
geometrically that is why the complex 
numbers will be built on the properties that 
we mentioned above. These tools will make 
us be able to take limits and do calculus. 
And, there will be a root of any complex 
equation. Also we tried to introduce some 
principle concept on the behavior of complex 
functions, such as holomorphic functions 
which are related with main theorem in 
complex analysis Riemann mapping 
theorem, Cauchy Riemann equations in 
order to prepare ourself to study harmonic 

mailto:nihad.shreef16@tu.edu.iq
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functions and its conjugate. In particular, 
series and sequences are treated " from 
scratch." This also has advantageous to see 
how would be easy to evaluate the integral of 
complex function through series, residues, 
Cauch theorem, First Cauchy integral 
formula and Second Cauchy integral formula 
(for derivative). consequence that power 
series, and the integration subject with 
(poles, removable singularity, essential 
singularity and residues theorem) are 
introduced in this course as well.



 

 
Use explanation and clarification to present concepts. 

• Interact with students through discussions and practical exercises. 

• Use real-life examples and applications to illustrate mathematical ideas. 
 

 

 
 

 
 

 
 

  

 
 
 

 
  

1-4 16 Field of complex 

numbers 

 

8   

5-6 8 Paths 8 

 

  

 

7-11 16 Functions of complex 8   

12-17 24 Some special 

functions and 

harmonic conjugate 

functions 

8   
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18-20 8 
Harmonic functions, 

their conjugates, and 

applications 

 

   

20-23 12 
Exponential, 

trigonometric, and 

compound hyperbolic 

functions 

 

   

24-30 24 
Logarithmic functions, 

properties of complex 

exponents, and their 

applications 

Path integral and 

Cauchy's theorem 

Cauchy-Gursat 

theorem and its 

applications 

 

 Cauchy's integral 

formula and its 

applications 
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Applications  

Complex functions for the third grade of physics 
 

A First Course in Complex Analysis with Applications (2003), Dennis G. Zill and Patrick D. Shanahan, 

Jones and Bartlett Publishers, London. 

 

 

 

Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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Course Name: 

      Mathematical Statistics 

Course Code: 

             

Semester / Year: 

            2024- 2025 

Description Preparation Date: 

          18- 9- 2024 

5. Available Attendance Forms: 
                Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

             (120 hour per year) / Number of Units (6 units) 

7. Course administrator's name (mention all, if more than one name) 

 Name:   LEC .Asmaa  Salih  Qaddoori 
Email:  asmaa. salih@tu.edu.iq  

 

  
• Mathematical statistics is considered one of the main 

topics in any mathematics program. The student usually 

studies the subject after studying the concept of the 

random variable, probability functions, and the properties 

of some statistical distributions, as the subject of 

mathematical statistics includes learning about the concept 

of transformations and the concept of estimates and their 

methods, in addition to: testing statistical hypotheses. 

• Emphasis on the study of inferring distributions using 

transformations 

• Identify the concept of estimation and its types 

• Identify estimation methods and the characteristics of a 

good appraiser 

• Be careful to introduce the concept of statistical 

hypothesis 







 

 
   •  

• Use explanation and clarification to present concepts. 

• Interact with students through discussions and practical exercises. 

• Use real-life examples and applications to illustrate mathematical 

ideas 

 

 
 

 
 

 
 

  

 
 
 

 
  

 

1 

 

4 

Learn how to use the 

moment generating 

function to extract 

statistical distributions.  

Using the moment generating 

function to extract statistical 

distributions for the discrete 

random variable and the 

continuous random variable 

Dying and 

discussion 

 

Daily and monthly 

testing and 

homework 

 



20 

 

 

2 

 

4 

Learn how to use 

transformations to derive 

statistical distributions for a 

discrete random variable.  

The concept of 

transformations and their use 

in deriving random 

distributions. 

 

= 

 

= 

 

3 

 

4 Learn how to use 

transformations to derive 

statistical distributions for a 

continuous random 

variable.  

The concept of the 

conversion factor and how to 

use it in deducing random 

distributions for a continuous 

random variable 

= = 

 

4 

 

4 

Exercises and discussion.  Solve some different 

exercises, monthly exam 
 

= 

 

= 

 

5 

 

4 Identify some distributions 

derived from other 

probability distributions.  

Defining the t-Student 

distribution and how to 

extract its probability 

function and some of its 

probabilistic properties 

 

= 

 

= 

 

 

6 

 

 

4 

Introducing the student to 

the F distribution and the 

Chi-square distribution.. 
The probability function of 

the F distribution and the 

Chi-square distribution, how 

to derive them, and their 

probabilistic properties 

 

 

= 

 

 

= 

7 4 Solve some different 

exercises.  

General questions and group 

assignments, monthly exam 
= = 

8 4 What is the concept of 

estimation and random 

interval?  

Explaining the concept of 

estimation and random 

interval and learning how to 

estimate with a period 

= = 

9 4 Introducing the student to 

grading by one point.  

Explain the concept of a 

confidence interval for a 

normal population mean 

= = 

10 4 Introducing the student to 

the concept of variation.  

Explain the concept of 

confidence interval for the 

variance of a normal 

population 

= = 

11 4 To understand the concept 

of the difference between 

averages.  

Find the confidence interval 

between the means 
= = 
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12 4 Solve some different 

exercises.  

Exercises, discussion, and 

monthly exam 
= = 

13 4 Introducing the student to 

grading methods.  

Maximum likelihood method, 

least variance method, and 

least squares method 

= = 

14 4 Introducing the student to 

the characteristics of a good 

appraiser.  

Definition of the concept of 

consistency and the concept 

of impartiality and some 

examples of them. 

 

= = 

15 4 Introducing the student to 

the concept of competence 

and efficiency 

Identify the efficient guesser 

with adequate statistics and 

the unbiased guesser with 

less variance. 

= = 

16 4 Explaining the analysis 

theorem and its 

applications.  

. 

Learn about the concept of 

the analysis theorem and how 

to use it to extract a sufficient 

estimate. 

 

= = 

17 4 Recognize the text of the 

theorem 

 Ro-Black Well. 

Presentation of the theorem 

and some of its applications 
= = 

18 4 Solve some different 

exercises.  

General questions and group 

assignments. 

 

= = 

19 4 . The characteristic of 

perfection with some 

examples and solutions to 

various exercises. 

Discussion and monthly 

exam. 
= = 

20 4 Learn about the concept of 

the exponential family 

 Introducing the student to 

the concept of the 

exponential family and 

identifying the members of 

the exponential function 

= = 

21 4 Solve some different 

exercises 

General exercises and group 

assignments 
= = 

22 4 The concept of statistical 

hypothesis.  

Defining the statistical 

hypothesis and distinguishing 

between the simple statistical 

hypothesis and the complex 

statistical hypothesis. 

 

= = 

23 4 Introducing the student to 

the types of statistical 

hypotheses. 

Definition of the null 

statistical hypothesis and the 

alternative statistical 

hypothesis. 

= = 

24 4 Identify random error and 

its types.  

Knowing random errors, their 

types, and how to distinguish 

between them. 

 

= = 
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25 4 Solve some different 

exercises. 

Discussion and monthly 

exam. 
=  

= 

26 4 Explain the concept of the 

critical  Rigen. 

. Definition of the critical 

region, test power, and 

characteristic function. 

 

= = 

27 4 How to choose the best 

critical point 

Introducing the student to the 

best area for testing and the 

best critical Rigen. 

= = 

28 4 Various exercises on the 

topic. 

 

Discussion and monthly 

exam 
 

= 
= 

29 4 Define more robust tests 

regularly 

Explain the Neyman-Pierson 

theorem and illustrate the 

concept of systematically 

more robust tests. 

 

= = 

30 4 Solve some different 

exercises 

General questions and group 

assignments 
= = 

11 . Course evaluation 
Distribution of the grade out of 100 according to the tasks assigned to the student, such as daily preparation, daily, oral, 

monthly, written exams, reports, etc.: 

• Daily preparation. 

• Daily exams. 

• Oral and monthly tests. 

• Written tests. 

• Preparing reports and research projects. 

• Quarterly activities and participation in discussions. 

• Student performance in class and interaction with study materials 

12 . Learning and teaching resources 
Required textbooks (methodology, if any) • Mathematical statistics, Amir Hanna Hormuz, 1990 

Main references (sources)  

 
   Introduction to mathematical statistic,   

Allen Craig  ,                 Robert V Hogg 

 Joseph W McKean  2005                       
   

• . Mathematical Statistics Amir Hanna Hormuz 1990 

Recommended supporting books and references (scientific 

journals, reports...)   

 

 Introduction to mathematical statistics 

                                         Robert V Hogg  

 Allen Craig 

Joseph W McKean  2005 

Electronic references, Internet sites   

 

University websites that provide educational materials in 

statistics and probability 

• Scientific articles and research available online in the 

field of statistics and probability. 
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Daily preparation. Daily exams.  Oral and monthly tests. Written tests. Preparing 

reports and research projects. Quarterly activities and participation in discussions. 

Student performance in class and interaction with his subjects 

 

 
Evaluation and Measurement - authored by 
Mustafa Mahmoud Al-Imam and others 

 
1- Evaluation and measurement in education and 
psychology, Sami Milhem, 2000. 2- Measurement 
and Evaluation in Education, Thomas George El 
Khoury, 2008. 3- Educational Measurement and 
Evaluation in the Teaching Process, Salah El-Din 
Mahmoud Allam, 2007. 

 

See all that is modern and published in refereed 
scientific journals 

 
http://www.alkutubcafe.com/book/83rjar.html 
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http://www.alkutubcafe.com/book/83rjar.html
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Course Description Form 
 

Course Name: fuzzy mathematics / fourth year 

 

Course Code: ----------- 

 

Semester / Year: 2025-2024 

 

Description Preparation Date:            2024-9-18 

 

5. Available Attendance Forms: Class lectures 
 

6. Number of Credit Hours (Total) / Number of Units (Total): 90 hours / 12 Units 

 

7. Course administrator's name (mention all, if more than one name) 

Name:  Asst. Prof. Hiba Omar Mousa 
hiba_34@tu.edu.iq 

 

 

The course develops and refines students’ information about the 

meaning of fuzzy mathematics and fuzzy theory  

 

 

  

 
 The standard method (giving lectures). 

 The text method. 

 Brainstorming method. 

 Some modern strategies. 

 

 

 
 

 
 

 

  

 
 

 

 
 

  
 

October  

 

2  Identify the main idea of a 

specific information about 

the fuzzy mathematics  

Standard method Class 

performance 

and exams 

mailto:hiba_34@tu.edu.iq
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November   

 

2  The difference between the 

fuzzy mathematics and the 

normal math. 

Standard method & 

Brainstorming 

method 

Class 

performance 

and exams 

December  

 

2  Definitions of the fuzzy sets 

and the fuzzy numbers  

Standard method & 

text method 

Class 

performance 

and exams 

January  

 

2  The Algebra of fuzzy sets Standard method & 

text method 

Class 

performance 

and exams 

February  2  Fuzzy relations  Standard method & 

text method 

Class 

performance 

and exams 

April  2  The stets of pieces at alpha 

level 

Standard method Class 

performance 

and exams 

March  2  Fuzzy symbol 

 

Standard method Class 

performance 

and exams 

May 

3&4 

-------  Final Exams ----------------- ---------------- 

 

11.   Learning Outcomes  

 Cognitive objectives of  Advanced Listening and speaking subject: 
A1-Remembering: At the level of remembering, the student must: 

1- The student knowing the fuzzy sets and the difference between them and between 

the normal stets 

2-  Recall the ideas used of the fuzzy math 

3- He has knowledge of the fuzzy theory  

A2-Understanding: The student must 

1- Organize ideas within each sets 

2- Elicits the uses of the form of fuzzy sets and fuzzy numbers 

3- Gives various ideas within the topic of each form 

4- Explain the use of the fuzzy rules mentioned within each sets 

A3- Application: The student must: 

1- Applies the sections, union and the analog differences  

2- Produces multiple ideas within each units 

3- Prepare various ideas and rules in each unit 

A4-Analysis: The student must... 

1- Distinguishes the use of the fuzzy math.  

2- knowing the types of fuzzy relationships 

3- It details the expressions that used in fuzzy math. 

4- Recognizes the importance of fuzzy theory in knowing the fuzzy relationships 

5- solution of theorems and problems  

6- knowing the types of sets and give examples and theorems.   
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12. Course Evaluation  

 

First Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Second Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Total for the 1st and 2nd Courses: 50 

Final Exam: 50 

Final Grade: 100 

13.   Learning and Teaching Sources 

Required textbooks  Yuan, B. “ Fuzzy sets and Fuzzy Logic” 

Main references (sources) Materials to be determined by course instructors 

Recommended books and references (scientific 

journal, reports 
Encyclopedia of scientific books and 

journals 
Electronic References, Websites Electronic lectures  
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Course Description Form 
  

Course Name: 

          Ring Theory  

Course Code: 
          Math.303 

Semester / Year: 

        Year 2024-2025  
Description Preparation Date: 

         18/9/2024 

5. Available Attendance Forms: 
         Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

            120 / 6 units  

7. Course administrator's name (mention all, if more than one name) 

 

Name:        Nada  Jasim Mohammed 
 
Email:       naya11415@tu.edu.iq 
 

 

 
 On completion of this course; the student will be abl understand fundamentals 

 concepts of Sequences series then study the convergence. 

 Also, study the Rim and Lubuge Integral 

 Identify the concept of Ring,Modulo,Representation, its types applications 

 



 

mailto:naya11415@tu.edu.iq


13  

 -We use examples and explain writing on board and so use discuses for 
more understand. So we give homeworks and discuses it. 

 - Brainstorming -Feedback at lecture time -Collaboration and feedback series 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

  

 

1.  

4 

-Student’s ability to 
distinguish and understand 
cognitively to diagnose 
special theories and 
principles. -Practice different 
styles of mathematics proofs. 
-Prossessing thinking skills 

 Definitions of Ring, 

commutative ring 

and ring with 

identity. 

 Discussion, exercises and exam 

2.  4 
= Divisors of 

zero,Integraldomain 
 Discussion, exercises and exam 

3.  
4 

= Subring,Field,Field 

of divisors 
 Discussion, exercises and exam 

4.  4 
= Ideals,Trivial and 

proper,Intersection 
 Discussion, exercises and exam 

5.  4 
= The center and 

characteristic of ring 
 Discussion, exercises and exam 

6.  4 = The principal ideal  Discussion, exercises and exam 

7.  
4 

= The smallest ideal, 

The principal ideal 

ring 

 Discussion, exercises and exam 

8.  4 
= The maximal ideal -

Zorn’s lemma 
 Discussion, exercises and exam 

9.  4 
= Cosets, Quotient 

ring 
 Discussion, exercises and exam 

10.  4 
= The prime ideal and 

example 
 Discussion, exercises and exam 

11.  4 
= The principal ideal 

domain 
 Discussion, exercises and exam 

12.  
4 

= The idempotent 

element, Boolean 

ring 

 Discussion, exercises and exam 

13.  4 
= Nilpotent element, 

Primary ideal 
 Discussion, exercises and exam 

14.  4 
= Ring 

homomorphism 
 Discussion, exercises and exam 

15.  4 
= Theorems of the 

ring 
 Discussion, exercises and exam 
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homomorphism, 

Kernel of 

homomorphism 

16.  

4 

= Theorems of kernel 

of homomorphism, 

Image and types of 

homomorphism 

 Discussion, exercises and exam 

17.  

4 

= The Natural 

mapping, 

Isomorphism and 

the 1st fundamental 

theorem 

 Discussion, exercises and exam 

18.  

4 

= The 2nd and 3rd 

fundamental 

theorem of 

Isomorphism 

 Discussion, exercises and exam 

19.  4 
= The division ring 

(Skew field) 
 Discussion, exercises and exam 

20.  4 = Radical ideal  Discussion, exercises and exam 

21.  4 
= Nil -radical ring  Discussion, exercises and exam 

22.  
4 

= Polynomials, Sum, 

Product, types of 

Polynomials  

 Discussion, exercises and exam 

23.  4 = Polynomials ring  Discussion, exercises and exam 

24.  
4 

= Polynomials field, 

Division algorithm 

 Discussion, exercises and exam 

25.  

4 

= Remainder and 

Factorization 

theorems, roots of 

polynomails 

 Discussion, exercises and exam 

26.  
4 

= Reducible& 

irreducible 

Polynomials 

 Discussion, exercises and exam 

27.  4 
=  Modules and 

submodules 
 Discussion, exercises and exam 

28.  4 
=  Modules 

homomorphism 
 Discussion, exercises and exam 

29.  4 
= Representation, 

some types 
 Discussion, exercises and exam 

30.  4 
= 

Examples  Discussion, exercises and exam 
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Distributing the score out of 100 according to the tasks assigned to the student such as 
daily preparation, daily oral, monthly, or written exams, reports .... etc 50 + 50 final 

 
 •Scientific articles and research available 

online in the field of statistics and probability 
 
 

- Introduction to modern abstract 
Algebra by :Dvaid M. Burton 
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 Course Description Form 
 

Course Name: 

Mathematical Analysis  

Course Code: 

Year 2024-2025   
Semester / Year: 

Physical attendance in the classroom/distance learning 

Description Preparation Date: 

            2024-9-18 

5. Available Attendance Forms: 

            2024-9-18 

6. Number of Credit Hours (Total) / Number of Units (Total) 

120 / 6 units  

7. Course administrator's name (mention all, if more than one name) 

 

Name:    Asst. prof. Zinah taha abdulqader 
 
Email:      ztaha@tu.edu.iq 
 

 

 

 On completion of this course; the student will be abl understand fundamentals 

 concepts of Sequences series then study the convergence. 

 Also, study the Rim and Lubuge Integral 


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We use examples and explain writing on board and so use discuses for more 
understand. So we give homeworks and discuses it. 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

  

 

31.  4  Ordered Sets  Discussion, exercises and exam 

32.  4 
 Dense of Rational numbers  Discussion, exercises and exam 

33.  
4 

 
Sequences of real numbers 

 Discussion, exercises and exam 

34.  4 
 Sequences of cauchy  Discussion, exercises and exam 

35.  4  Convergent sequences  Discussion, exercises and exam 

36.  4  Test of convergence  Discussion, exercises and exam 

37.  4  Metric Spaces  Discussion, exercises and exam 

38.  4  Example for Metric spaces  Discussion, exercises and exam 

39.  4  Accumulation Points  Discussion, exercises and exam 

40.  4            Open and Closed Sets  Discussion, exercises and exam 

41.  4  Compact Sets  Discussion, exercises and exam 

42.  4 
 

Compact Sets 
 Discussion, exercises and exam 

43.  4  Tests  Discussion, exercises and exam 

44.  4  Continuity  Discussion, exercises and exam 

45.  4 
 Continuity  Discussion, exercises and exam 

46.  4  Compact and Continuity  Discussion, exercises and exam 

47.  4  Convergence and Continuity  Discussion, exercises and exam 

48.  4  Uniform continuous  Discussion, exercises and exam 

49.  4                   Partition  Discussion, exercises and exam 

50.  4  Riemman Integral  Discussion, exercises and exam 

51.  4  Properties of Rimman Integral  Discussion, exercises and exam 

52.  4  Rimman Stlijest  Discussion, exercises and exam 
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53.  4  Measure of Bouneded Sets  Discussion, exercises and exam 

54.  
4 

 
Measure of unbounded Sets 

 Discussion, exercises and exam 

55.  4  Measureable function  Discussion, exercises and exam 

56.  4  UnMeasurable  Discussion, exercises and exam 

57.  4  Theorems and Examples  Discussion, exercises and exam 

58.  4  Theorems  Discussion, exercises and exam 

59.  4  Theorems and Examples  Discussion, exercises and exam 

60.  4 
 Examples  Discussion, exercises and exam 
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Course Description Form 
 

Course Name: fuzzy mathematics / fourth year 

 

Course Code: ----------- 

 

Semester / Year: 2025-2024 

 

Description Preparation Date: 18/9/2024 

 

5. Available Attendance Forms: Class lectures 
 

6. Number of Credit Hours (Total) / Number of Units (Total): 90 hours / 12 Units 

 

7. Course administrator's name (mention all, if more than one name) 

Name:  Asst. Prof. Hiba Omar Mousa 
hiba_34@tu.edu.iq 

 

 

The course develops and refines students’ information about the 

meaning of fuzzy mathematics and fuzzy theory  

 

 

 

 

 

 The standard method (giving lectures). 

 The text method. 

 Brainstorming method. 

 Some modern strategies. 

 

 

 
 

 
 

 

  

 
 

 

 
 

  
 

October  

 

2  Identify the main idea of a 

specific information about 

the fuzzy mathematics  

Standard method Class 

performance 

and exams 

mailto:hiba_34@tu.edu.iq
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November   

 

2  The difference between the 

fuzzy mathematics and the 

normal math. 

Standard method & 

Brainstorming 

method 

Class 

performance 

and exams 

December  

 

2  Definitions of the fuzzy sets 

and the fuzzy numbers  

Standard method & 

text method 

Class 

performance 

and exams 

January  

 

2  The Algebra of fuzzy sets Standard method & 

text method 

Class 

performance 

and exams 

February  2  Fuzzy relations  Standard method & 

text method 

Class 

performance 

and exams 

April  2  The stets of pieces at alpha 

level 

Standard method Class 

performance 

and exams 

March  2  Fuzzy symbol 

 

Standard method Class 

performance 

and exams 

May 

3&4 

-------  Final Exams ----------------- ---------------- 

 

11.   Learning Outcomes  

 Cognitive objectives of  Advanced Listening and speaking subject: 
A1-Remembering: At the level of remembering, the student must: 

1- The student knowing the fuzzy sets and the difference between them and between 

the normal stets 

2-  Recall the ideas used of the fuzzy math 

3- He has knowledge of the fuzzy theory  

A2-Understanding: The student must 

1- Organize ideas within each sets 

2- Elicits the uses of the form of fuzzy sets and fuzzy numbers 

3- Gives various ideas within the topic of each form 

4- Explain the use of the fuzzy rules mentioned within each sets 

A3- Application: The student must: 

1- Applies the sections, union and the analog differences  

2- Produces multiple ideas within each units 

3- Prepare various ideas and rules in each unit 

A4-Analysis: The student must... 

1- Distinguishes the use of the fuzzy math.  

2- knowing the types of fuzzy relationships 

3- It details the expressions that used in fuzzy math. 

4- Recognizes the importance of fuzzy theory in knowing the fuzzy relationships 

5- solution of theorems and problems  

6- knowing the types of sets and give examples and theorems.   
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12. Course Evaluation  

 

First Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Second Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Total for the 1st and 2nd Courses: 50 

Final Exam: 50 

Final Grade: 100 

13.   Learning and Teaching Sources 

Required textbooks  Yuan, B. “ Fuzzy sets and Fuzzy Logic” 

Main references (sources) Materials to be determined by course instructors 

Recommended books and references (scientific 

journal, reports 
Encyclopedia of scientific books and 

journals 
Electronic References, Websites Electronic lectures  
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Course Name: 

          Partial Differential Equation  

Course Code: 
          Math.406 

Semester / Year: 

        Year 2024-2025  
Description Preparation Date: 

         18/9/2024 

5. Available Attendance Forms: 
         Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

            90 / 4 units  

7. Course administrator's name (mention all, if more than one name) 

 

Name:        Amer Fadhel Nassar 
 
Email:       amer6767@tu.edu.iq 
 

 

 
• To learn about integration methods. 
• To understand the reality of the derivative and the reality of integration 
• To learn the connection between them 
• To learn about ordinary differential equations 
• To learn about partial differential equations 
• To learn about types of partial differential equations 
• To understand the classification of partial differential equations 
• To understand some applications of partial differential equations 
• To understand derivation and integration and their relationship to partial differential 
equations 
• To know the relationship between ordinary differential equations and partial differential 
equations 



 

 -We use examples and explain writing on board and so use discuses for 
more understand. So we give homeworks and discuses it. 

 - Brainstorming -Feedback at lecture time -Collaboration and feedback series 

 

mailto:amer6767@tu.edu.iq
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1-2-

3 

9 

Second order partial 

differential equations 

Classification of 

equations: second 

order partial 

differential 

equations, nth order 

partial differential 

equations, Fourier 

series 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

4-5-
6 

9 

Types of second order 

partial differential 

equations with variable 

coefficients and methods 

of solving them 

Study of different 

types of equations 

with variable 

coefficients and 

methods of solving 

them, Laplace 

transform to solve 

this type of partial 

equations 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

7-8-
9 

9 

Heat diffusion equation Heat diffusion 

equation in an 

isolated metal arm 

and homogeneous 

boundary 

conditions, Heat 

diffusion equation in 

an isolated metal 

arm and 

heterogeneous 

boundary 

conditions, Heat 

diffusion equation in 

an isolated metal 

arm limits 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

10-
11-

12 

9 

Wave equation in one 

dimension and in two 

dimensions 

Forming the wave 

equation and 

methods of solving 

it in one or two 

dimensions, applied 

problems on the 

wave equation 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

13-
14-

15 9 

Laplace-Poisson equation Solving Laplace's 

equation in two 

dimensions using 

the method of 

separation of 

E-

lectures, 

smart 

board 

Exam, Reports 
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variables, Laplace's 

equation in polar 

coordinates and its 

solution 

and pen 

 

  12. Learning and teaching resources 

1- Required textbooks 1- Partial Differential Equations for Scientific and Engineering Colleges 

/ Translated by Dr. Atta Allah Thamer Al-Ani 1989 

2- Partial Differential Equations / Dr. Atta Allah Thamer Al-Ani 

3- Introduction to Partial Differential Equations / Dr. Atta Allah Thamer 

Al-Ani 

4- Khaled Ahmed Al-Samarrai, Yahya Abdul Saeed: Methods of Solving 

Differential Equations. 

5- Salim Ismail Al-Gharabi, Sabah Hadi Al-Jassim: Differential 

Equations. 

2- Main references 

(sources) 
 S. K. Kate:  Engineering 

Mathematics – II 

 Partial differential  
Equations  Jhon. F. 

 

A- Recommended books 

and references (scientific 

journals, reports, etc.) 

Thomas calculus 12th edition 
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Course Description Form 
 

Course Name: 

      Statistics and Probability 

Course Code: 

         Math .    

Semester / Year: 

            2024- 2025 

Description Preparation Date: 

          18- 9- 2024 

5. Available Attendance Forms: 
                Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

             (120 hour per year) / Number of Units (6 units) 

7. Course administrator's name (mention all, if more than one name) 

 Name:   LEC .Asmaa  Salih  Qaddoori 
Email:  asmaa. salih@tu.edu.iq  

 

 • Learn about the concept of 

statistics and the most important statistical measures 

• Study random variables and learn about their types and 

probability functions. 

• Learn about the first principles of probability and 

random experimentation. 

• Identify the functions that generate moments. 

• Be careful to introduce the most important statistical 

distributions and know the properties of each distribution. 







 

 
   • Use explanation and clarification to present concepts. 

• Interact with students through discussions and practical exercises. 

• Use real-life examples and applications to illustrate mathematical 

ideas. 
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1 

 

4 

Definition of the principles 

of statistics 

The concept of descriptive 

statistics, statistical 

population, the concept of 

sample and its types 

Dying and 

discussion 

 

Daily and monthly 

testing and 

homework 

 

 

2 

 

4 

Define measures of central 

tendency 

 

Definition of the arithmetic 

mean, median, and mode for 

classified and non-classified 

data 

 

= 

 

= 

 

3 

 

4 Measures of dispersion 

 

Variance, standard deviation, 

range measures, and 

coefficient of variation 

 

= = 

 

4 

 

4 

Definition of correlation 

and linear regression 

Correlation coefficient and 

simple linear regression 

equation 

  

= 

  

= 

 

5 

 

4 Exercises and discussion 

 

Solve some different 

exercises 
 

=    

  

         = 

 

 

6 

 

 

4 

Definition of probability 

and random experiment The most important laws of 

probability, the axioms of 

probability, and the most 

important theorems of 

probability 

 

 

 

= 

 

 

= 

7 4 Learn about the most 

important counting 

methods 

The concept of combinations 

and permutations 
 

= 

 

= 

8 4 Solve some different 

exercises 

General questions and group 

assignments 
 

= 

 

 

= 

9 4 The concept of random 

sampling 

Discussion, monthly exam  

= 

 

= 

10 4 Introducing the student to 

the concept of field and 

probability space 

Identify independent, 

dependent, and mutually 

exclusive incidents 

 

= 

 

= 

11 4 To understand the concept 

of conditional probability 

Conditional probability and 

some of its theorems 
 

= 

 

= 
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12 4 Learn about Bayes' theorem Bayes' theorem and its most 

important probabilistic 

applications 

 

= 

 

= 

13 4 Solve some different 

exercises 

Exercises and discussion  

= 

 

= 

14 4 The concept of random 

variable and its types 

The student knows the 

concept of discrete random 

variables and continuous 

random variables and their 

respective probability 

functions 

 

= 

 

= 

15 4 Introduce the student to the 

concept of the distributive 

function.  

The distribution function in 

the case of a discrete random 

variable and in the case of a 

continuous random variable 

 

= 

 

= 

16 4 The concept of 

mathematical expectation 

and variance 

Discussion and monthly 

exam 
 

= 

 

= 

17 4 For the student to become 

familiar with the concept of 

the function generating 

moments 

 Derivation of the moment 

generating function for the 

discrete random variable and 

the continuous random 

variable 

 

= 

 

= 

18 4 Solve some different 

exercises 

General questions and group 

assignments 
 

= 

 

= 

19 4 Identify the probability 

distribution of two random 

variables.  

The joint probability function 

for discrete random variables 

and continuous random 

variables 

 

= 

 

= 

20 4 Conditional function and 

conditional probability 

 The conditional probability 

of two random variables 
 

= 

 

= 

21 4 The concept of expectation 

for two random variables.  

The mathematical 

expectation of two random 

variables if the variables are 

discrete and if the variables 

are continuous 

 

= 

 

 

= 

22 4 Solve some different 

exercises. 

General questions and group 

assignments 
 

= 

 

= 

23 4 Introducing the student to 

the function that generates 

the moments of two 

random variables.  

The function generating the 

moments of two random 

variables, whether the 

variables are discrete or 

continuous 

 

= 

 

= 
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24 4 Solve some different 

exercises.  

Discussion and monthly 

exam 
 

= 

 

= 

25 4 Introducing the student to 

some statistical 

distributions.  

Uniform distribution of 

discrete and continuous 

random variables 

 

= 

 

= 

26 4 Solve some different 

exercises. 

Exercises and discussion  

= 

 

= 

27 4 Familiarize the student with 

the binomial distribution 

function.  

The probability function of 

the binomial distribution and 

its probability properties 

 

= 

 

= 

28 4 Introducing the student to 

the gamma  

distribution. Probability 

function of gamma 

distribution and chi-square 

distribution 

 

= 

 

= 

29 4 Familiarize the student with 

the normal distribution.  

The probability function of 

the normal distribution, the 

exponential distribution, and 

the Poisson distribution 

 

= 

 

= 

30 4 Solve some different 

exercises.  

General questions, group 

assignments, and a monthly 

exam 

 

= 

 

= 

11 . Course evaluation 
Distribution of the grade out of 100 according to the tasks assigned to the student, such as daily preparation, daily, oral, 

monthly, written exams, reports, etc.: 

• Daily preparation. 

• Daily exams. 

• Oral and monthly tests. 

• Written tests. 

• Preparing reports and research projects. 

• Quarterly activities and participation in discussions. 

• Student performance in class and interaction with study materials 

12 . Learning and teaching resources 
Required textbooks (methodology, if any) • Mathematical statistics, Amir Hanna Hormuz, 1990 

Main references (sources)  

 
• Introduction mathematical statistics 

   1980 G.P. Beaumont 

• . Mathematical Statistics Amir Hanna Hormuz 1990 

Recommended supporting books and references (scientific 

journals, reports...)   

 

Introduction mathematical statistics 

 G.P. Beaumont 1980 

Electronic references, Internet sites   

 

University websites that provide educational materials in 

statistics and probability 

• Scientific articles and research available online in the 

field of statistics and probability. 



9  
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Course Description Form 
 

Course Name: 

          Partial Differential Equation  

Course Code: 
          Math.406 

Semester / Year: 

        Year 2024-2025  
Description Preparation Date: 

         18/9/2024 

5. Available Attendance Forms: 
         Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

            90 / 4 units  

7. Course administrator's name (mention all, if more than one name) 

 

Name:        Amer Fadhel Nassar 
 
Email:       amer6767@tu.edu.iq 
  

 

 
• To learn about integration methods. 
• To understand the reality of the derivative and the reality of integration 
• To learn the connection between them 
• To learn about ordinary differential equations 
• To learn about partial differential equations 
• To learn about types of partial differential equations 
• To understand the classification of partial differential equations 
• To understand some applications of partial differential equations 
• To understand derivation and integration and their relationship to partial differential 
equations 
• To know the relationship between ordinary differential equations and partial differential 
equations 



 

mailto:amer6767@tu.edu.iq
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 -We use examples and explain writing on board and so use discuses for 
more understand. So we give homeworks and discuses it. 

 - Brainstorming -Feedback at lecture time -Collaboration and feedback series 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

  

 
1-2-

3 

9 

Second order partial 

differential equations 

Classification of 

equations: second 

order partial 

differential 

equations, nth order 

partial differential 

equations, Fourier 

series 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

4-5-
6 

9 

Types of second order 

partial differential 

equations with variable 

coefficients and methods 

of solving them 

Study of different 

types of equations 

with variable 

coefficients and 

methods of solving 

them, Laplace 

transform to solve 

this type of partial 

equations 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

7-8-
9 

9 

Heat diffusion equation Heat diffusion 

equation in an 

isolated metal arm 

and homogeneous 

boundary 

conditions, Heat 

diffusion equation in 

an isolated metal 

arm and 

heterogeneous 

boundary 

conditions, Heat 

diffusion equation in 

an isolated metal 

arm limits 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

10-
11-

12 9 

Wave equation in one 

dimension and in two 

dimensions 

Forming the wave 

equation and 

methods of solving 

it in one or two 

E-

lectures, 

smart 

Exam, Reports 
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dimensions, applied 

problems on the 

wave equation 

board 

and pen 

13-
14-

15 

9 

Laplace-Poisson equation Solving Laplace's 

equation in two 

dimensions using 

the method of 

separation of 

variables, Laplace's 

equation in polar 

coordinates and its 

solution 

E-

lectures, 

smart 

board 

and pen 

Exam, Reports 

 

  12. Learning and teaching resources 

1- Required textbooks 1- Partial Differential Equations for Scientific and Engineering Colleges 

/ Translated by Dr. Atta Allah Thamer Al-Ani 1989 

2- Partial Differential Equations / Dr. Atta Allah Thamer Al-Ani 

3- Introduction to Partial Differential Equations / Dr. Atta Allah Thamer 

Al-Ani 

4- Khaled Ahmed Al-Samarrai, Yahya Abdul Saeed: Methods of Solving 

Differential Equations. 

5- Salim Ismail Al-Gharabi, Sabah Hadi Al-Jassim: Differential 

Equations. 

2- Main references 

(sources) 
 S. K. Kate:  Engineering 

Mathematics – II 

 Partial differential  
Equations  Jhon. F. 

 

A- Recommended books 

and references (scientific 

journals, reports, etc.) 

Thomas calculus 12th edition 
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Course Description Form 

1. Course Title : Numerical Analysis 

 

2. Course Code 

 

3. Semester/Year: 2024-2025 

 

4. Date of preparation of this description: 18/9/2024 

 

5. Available forms of attendance: physical or electronic 

 

6. Number of credit hours (total) / number of units (total): 6 

 

7. Course administrator's name (if more than one name is mentioned)  

         Name: Assoc. Prof. Mohamed Abdel Mohaimeed Email: 

mohammad.sabawi@tu.edu.iq 

8. Course Objectives 

Course Objectives  
• Definition of numerical analysis and its 

most important applications. 
• Understand numerical methods and how 

to use them. 
• Understand numerical error and the 

concept of relative error. 
• Identify numerical methods Numerical 

algorithms. 
• Study of convergence and its concepts 

• Understanding stability and its 
applications in real life 

9. Teaching and learning strategies 

Strategy  
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•  The use of explanation and clarification in 
presenting concepts. 

•   Interact with students through practical 
discussions and exercises. 

  Use real-life examples and applications to 

illustrate mathematical ideas. 

10. Course Structure 

The week Hours Required 
Learning 

Outcomes 

Unit or subject name Learning 
method 

Evaluation 
method 

1 4  
Chapter One 

Theoretical: Analysis of 
errors / sources of errors / 
errors in calculations. 
Practical: Relative error 
and absolute error 
software.  

Lecture and 
discussion 

Daily and 
monthly test 
Homework 

4 16  
Chapter Two 

Theoretical: Nonlinear 
Equations / Determination 
of Roots Locations / 
Interval Half-Period 
Method / Secant Method / 
Solid Point Iterative 
Method / Convergence of 
Iterative Methods / 
Newton-Raphson Method / 
Finding Roots for 
Polynomials / Methods of 
Solving a System of 
Nonlinear Equations / 
Peersto Method. 
Practical: Interval halving 
method program, secant 
method program, Newton-
Raphson method program, 
iterative point method 
program, nonlinear 
equation solution program. 

= = 

4 16  
 

   Chapter 
Three 

Theoretical: Linear Systems 
Solutions / Kaos Method of 
Deletion / Kaus-Gordon 
Method / Partial Pivot / 
Cramer Method / 
Trigonometric Analysis 
Method. 
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Practical: Cramer method 
software to solve a system 
of linear equations, using a 
function in the MATLAB to 
calculate better 
coefficients of multiple 
data compatibility limits. 

4 16  
 
 

Chapter Four 

Theoretical: Insertion and 
Interpolation / Finite 
Differences / Newton's 
Progressive and Regressive 
Method / Bessel Formula 
and Sterlink's Formula for 
Insertion / Relative 
Differences Method / 
Lakrang's Formula / 
Horizontal Curves. 
Practical: Newton's 
progressive method 
program, Newton's 
regressive method 
program, 
Sterlink formula program 
for insertion, Lakrang 
method program (first 
idea), Lakrang method 
program (second idea). 

= = 

4 16  
Chapter Five 

Theoretical: Integral and 
Numerical Virtue / 
Newton's Formulas for 
Numerical Differentiation / 
Trapezoidal Rule for 
Numerical Integral / 
Simpson Rule / Three 
Eighths Rule / Paul's Rule / 
Weddell's Rule / Romberg's 
Method for Improving 
Results / Kaos Quadratic 
Numerical Integration 
Methods / Kauss Gender 
Method. 
Practical: Trapezoidal rule 
program for numerical 
integration, Simpson rule 
program, three-eighths rule 
program. 

  

4 16  Theoretical: Solutions of = = 
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Chapter VI the differential equation / 
Tyler series method / 
Euler's explicit method / 
Euler's developed method / 
Runge-Kuta method / 
Solving a system of 
differential equations. 
Practical: Runge-Kuta 
method program. 

2 8 Chapter VII Theoretical: The concept of 
convergence and the 
concept of stability / the 
concept of absolute 
continuity. 

= = 

 

 

 

 

 

11. Course Evaluation 

Distributing the score out of 100 according to the tasks assigned to the student 

such as daily preparation, daily, oral, monthly, written exams, reports... Etc: 

• Daily preparation. 
• Daily exams. 
• Oral and monthly tests. 
• Written tests. 
• Preparing reports and research projects. 
• Quarterly activities and participation in discussions. 
• Student performance in class and interaction with study materials 

 

12. Learning and Teaching Resources 

Required textbooks (methodology, if any) Principles of Numerical Analysis - 

Written by: Dr. Ali Muhammad Sadiq 

Saifi - Dr. Ebtisam Kamal Al-Din       

Key references (sources) Numerical Analysis" 9th Edition ; Richard 

L. Burden & J. Douglas Faires, 2011. 

Recommended books and references Instructor's Manual for Numerical 
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(scientific journals, reports...) Analysis" ; Richard L. Burden & J. 

Douglas Faires, 2005. 

Electronic References, Websites • University websites that offer 
teaching materials in numerical 
analysis. 

• Online scientific articles and 
research in the field of numerical 
analysis. 
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                          Course Description Form 
 

Course Name: 

    Group Theory  

Course Code: 

     Math.201 

Semester / Year: 

     2024-2025  

Description Preparation Date: 

    18/9/2024  

5. Available Attendance Forms: 
    Classroom and Google Classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

    90 hour / 5 unite 

7. Course administrator's name (mention all, if more than one name) 
Name: Nada Jasim Mohammed  
Email: naya11415@tu.edu.iq  
 
 
 

 
 

 
Identify the concept of group, its types an 

Applications 

 



 

 
   -Brainstorming -Feedback at lecture time -Collaboration and feedback series 
 
 

 

 
 

 
 
 

 
  

 
 

mailto:naya11415@tu.edu.iq
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  1-4 

    
 
 
 
 
 

  5-8 
 
 
 
 
  9-12 
 
 
 
  13-16 
 
 
 
  17-20 
 
 
 
  21-25 
 
 
 
 
 
  26-30 

  12 
      
 
 
 
 
 
12 
 
 
 
 
  12 
 
 
 
  12 
 
 
 
  12 
 
 
 
  15 
 
 
 
 
 
  15 

 Student’s ability to - 
principles. theories and 
diagnose special 
cognitively to 
understand distinguish 
and Practice different - 
proofs. styles of 
mathematics Prossessing 
thinking skills. 

= 
 
 
 
 
 

= 
 
 
 
 
                   = 
 
 
 
 
 
                    = 
 
 
 
 
                   = 
 
 
 
 
 
       
                 = 
 
 

               

 system, Mathematics 
Definitions of binary 
operation, Group and 
semi group.  
 

 

Define agroup , 
Basic theorems of 

group ,Symmetric 

group , Group of 
modulo n . 

 
 Theorems of group 
of modulo n ,Cyclic 
group , Subgroups 
 
  Lagrange theorem,   
Normal groups , The 
normal elements and 
subgroups,Simple 
groups, Quotient 
group. 
 
 Internal and External 
direct product , 
Homomorphism, 
Isomorphism. 
The 1st fundamental 
theorem of 
Isomorphism, The 
2nd and 3rd 
fundamental theorem 
of Isomorphism.  
 
 Chain, Jorden-
Holder theorem , 

Cayley’s theorem , P-

group, Sylow 
theorems                              

  Deductive -
Induction -
Discussion -
Using Data 
Show and white 
board . 
 
 
 
        = 

 
 
 
 
 

= 
 
 
 
 

= 

 

 

 

      
           =    

 

= 

 

= 

 

 

 

 

 

= 

Oral  discussion 
-Daily exams 

Monthly exams Homework  - 
assignments – 

 
 
 

 
= 

 

 

 

 
= 

 

 

 
= 
 
 
 
 
 

= 
 
 

= 
 
 

= 
 
 
 
 
 

= 
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Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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Course Description Form 
 

Course Name: 

Euclidean geometry 

Course Code: 
Math.203 

Semester / Year: 
2024-2025 

Description Preparation Date: 
18/9/2024 

5. Available Attendance Forms: 
 

6. Number of Credit Hours (Total) / Number of Units (Total) 
90 hour/ 5 units 

7. Course administrator's name (mention all, if more than one name) 
Name:Fatin Haitham Mawlood 

Email: Fatin.Haitham@tu.edu.iq 

 

Course Objectives 

 
 

 Good, correct, and integrated knowledge 

and understanding of engineering.

• Identify the concept of the intuitive system 

 • Learn about the concept of the intuitive system. 

 

 • Using explanation and clarification to present concepts through discussion, 

analysis and scientific thinking 

• Using different proof methods to prove the basic theorems of geometry 

 

 

 

 
  

  

 

  
 

mailto:Fatin.Haitham@tu.edu.iq
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1-4 

 

 

 

12 
Knowledge of the origins 

and development of the 

intuitive system 

The Yonck/Fano 

axiomatic system 

 

 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

 

5-8 12 
Properties of the 

axiomatic system: 

consistency/independence 

Properties of the 

axiomatic system 

 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

 

9-12 12 The Hilbertian system 

definition/cuts and 

convex sets 

Evaluation of 

Euclid's geometry 

(foundations of 

geometry) 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

13-16 12 Re-proof of some of 

Euclid's theorems 

Elementary 

engineering Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

17-20 12 Elliptical definitions and 

theorems 

 

 

 

 

 

Euclidean geometry 
Electronic 

lectures, lecture 

method, smart 

board and pen 

Exams with 

homework 

and reports 

21-25 15 Study of structural 

projective geometry Synthetic projective 

plane 

 

Electronic 

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework 

and reports 

26-40 15 Study of the analytical 

damage level 

 

The analytical 

projective level 

Electronic 

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework 

and reports 
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Distributing the score out of 100 according to the tasks assigned to the student such as 
daily 
preparation, daily oral, monthly, or written exams, reports .... etc 

 

 
• Basic concepts in engineering (Amal Shehab Al-

Mukhtar). 

 • Axiom, geometry, and non-Euclidean systems 

(Nouri Farhan Al-Mayahi) 

• Axiom and geometry systems (Abdul Wahab 

Ahmed Al-Sarraj) 
 

 

 

 
Internet sites 
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Course Description Form 
 

Course Name:  

        Advanced Calculus   

Course Code: 

            Math.101 

Semester / Year:  

         2024-2025 

Description Preparation Date: 

18-9-2024  

5. Available Attendance Forms: 

Weekly 

6. Number of Credit Hours (Total) / Number of Units (Total) 

         150 hours /  8 unit 

7. Course administrator's name (mention all, if more than one name) 
 

Name:   Elaf  Sabah  Abdulwahid  

  Email:   elafs.math@tu.edu.iq  

 

 

- Study and knowledge of sequences and series.   

- Study and knowledge of some types test of the series. 

- Study some properties of absolute converge and conditionally converge

- Study and knowledge polar coordinates.

- Study draw in a polar coordinates.

- Study and knowledge intersection in a polar coordinates

- Study and knowledge double  integrals and some applications.

Study and knowledge triple integrals. 



 

mailto:elafs.math@tu.edu.iq
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Applying various teaching methods ,including  

- Giving lectures  

Discussion method and electronic method. 

 

 
 

 
 

 
 

  

 
 
 

 
  

1-2 10 Study of infinite sequences 

 

  Infinite sequences  Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

3-4 10  Study of some type of 

infinite series with some 

examples.  

 Infinite series Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

5-8 20  Study of some type test of 

infinite series with 

examples  

 Infinite series Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

9-11 15 Study of Absolute 

converge and conditionally 

converge 

Absolute converge and 

conditionally converge 

Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

12-15 20 Study of first  and second 

derivatives 

Derivatives  Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

16-18 15 Study of Taylor and 

Maclorin series. 

Taylor and Maclorin 

series. 

Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

19-21 15 Study of Polar coordinates Polar coordinates  Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

22-24 15 Study area and length of a 

Polar coordinates 

Application of Polar 

coordinates  

Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

25-27 15 Study of Double integrals Double integrals Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 

28-30 15 Study of Triple integrals Triple integrals Electronic 

lectures, smart 

board ,pens 

Written and 

daily exams with 

assignments 



9  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.  Course Evaluation 
Distributing the score out of 100 according to the tasks assigned to the student 
such as daily preparation, daily oral, monthly, or written exams, reports… 

 

 

12. Learning and Teaching Resources  
Required textbooks (curricular books, if any) 

 
 

 Advanced calculus , second edition 

Thomas. 

 

Main references (sources)  التفاضل والتكامل تاليف رمضان محمد جهيميه
 واحمد عبد العالي

Recommended books and references 
(scientific journals, reports...) 

 سلسلة شوم في التفاضل المتقدم

Electronic References, Websites  
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Course Description Form 

1. Course Name 
Computers 

2. Course Code 
 

3. Semester/Year 
2024-2025 

4. Date of Preparation 

18/9/2024 

5. Available Attendance Forms 
Distance Learning / In-person 

6. Total Study Hours / Units 
60 hours / 3 units 

7. Course Coordinator 
Name: Mohammed Muayad Sultan 
Email: mmsultan@tu.edu.iq 

8. Course Objectives 
 To teach students how to use computers in ready-made applications like Microsoft Office through 

interactive learning, dealing with windows, saving programs, and writing notes to ensure the 

execution of applications and programs. 

 To describe ready-made applications and software and acquire computer skills. 

 To develop self-improvement skills that enable students to compete with others. 

 To meet the needs of the education sector with highly efficient staff. 

9. Teaching and Learning Strategies 
 Using explanation and clarification to present concepts. 

 Interaction with students through discussions and practical exercises. 

 Practical application in the laboratory. 

 Video lectures. 

 Electronic presentations. 
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10. Course Structure 
Week Hours Learning Outcomes Unit or Topic 

Name 
Learning Method 

1 4 Introduction to application programs Word Processor 
2010 

Lecture and 
discussion - Lab 

2 4 Getting to know the Microsoft Office 
interface 

Word Processor 
2010 

= 

3 4 Working on the Office button and Quick 
Access Toolbar 

Word Processor 
2010 

= 

4 4 Working on the Home tab Word Processor 
2010 

= 

5 4 Working on the Insert tab - Table Word Processor 
2010 

= 

6 4 Working on the Insert tab - Table - 
Design 

Word Processor 
2010 

= 

7 4 Working on the Insert tab - Table - 
Layout 

Word Processor 
2010 

= 

8 4 Working on the Insert tab - Picture Word Processor 
2010 

= 

9 4 Working on the Insert tab - Picture - 
Format 

Word Processor 
2010 

= 

10 4 Working on the Insert tab - Picture - 
Design 

Word Processor 
2010 

= 

11 4 Working on the Insert tab - Shapes - 
Format 

Word Processor 
2010 

= 

12 4 Working on the Page Layout tab Word Processor 
2010 

= 

13 4 Working on the Page Layout tab Word Processor 
2010 

= 

14 4 Working on the File tab Word Processor 
2010 

= 

15 4 Working on the File tab - Save and 
Retrieve 

Word Processor 
2010 

= 

16 4 How to insert tables and pictures and 
deal with them 

Word Processor 
2010 

= 

17 4 Working on the References and 
Mailings tab 

Word Processor 
2010 

= 

18 4 Working on the Review and View tab Word Processor 
2010 

= 

19 4 Working on the Home tab PowerPoint 2010 = 
20 4 Working on the Home tab PowerPoint 2010 = 
21 4 Working on the Insert tab PowerPoint 2010 = 
22 4 Working on the Transitions tab and 

related tabs 
PowerPoint 2010 = 

23 4 Working on the Transitions tab and 
related tabs 

PowerPoint 2010 = 

24 4 Working on the Animations tab and 
related tabs 

PowerPoint 2010 = 

25 4 Working on the Animations tab and 
related tabs 

PowerPoint 2010 = 

26 4 Working on the Design tab PowerPoint 2010 = 
27 4 Working on the Slide Show tab PowerPoint 2010 = 
28 4 Working on the Review tab PowerPoint 2010 = 
29 4 Working on the View tab PowerPoint 2010 = 
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30 4 Working on the File tab PowerPoint 2010 = 

11. Course Evaluation: 
 Daily preparation. 

 Daily exams. 

 Oral and monthly tests. 

 Written tests. 

 Preparing reports and research projects. 

 Classroom activities and participation in discussions. 

 Student performance in class and interaction with study materials. 

12. Learning and Teaching Resources: 
 Required textbooks (if available): Basics of Computers and Office Applications. 

 Main references (sources): Recommended books and supporting references (e.g., reports, scientific 

journals). 

 Electronic references, websites: Many educational websites and video clips on YouTube. 
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Course Description Form 
 

Course Name: 

         Computer 

Course Code: 

 

Semester / Year: 

5202/2024  

Description Preparation Date: 

18/9/2024 

5. Available Attendance Forms: 

Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

60 hours 

7. Course administrator's name (mention all, if more than one name) 
Name :  Farah Amer Abd Alziz 
Emil :  farah.amer@tu.edu.iq 

 

 
• The student gets to know the concept of 
computer science 
• The student should be familiar with the 
personal computer 
• For the student to recognize the difference 
and relationship between software and the 
physical parts inside the computer 
• For the student to recognize the importance 
of using a computer 
• The student gets to know how the internal 
computer parts work 
• The student gets to know the concept of 
information that the computer deals with and 
its classification 
• The student will know how information 
enters and exits to and from the computer 
• The student gets to know some operating 
systems 
• The student gets to know the relationship 
between operating systems and hardware 
• That the student be able to maintain some 
parts of the computer 
• For the student to learn about the benefits of 
the computer in his general life 
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• The student will know how  used the 
Microsoft Word 
•The student will know how  used the 
Microsoft PowerPoint 
•The student will know how  used the printer 
to Print documents 
•The student will know how  used the Internet, 
networking, and email creation 
 
• That the student be able to know the internal 
parts of the computer in a concrete way 
• Introducing the student to concepts and 
strategies for computer operation 

 

 
To apply what he has learned for the purpose of solving many issues 

and problems in the same subject 

-Distinguishes how information enters and exits from and to the 

computer 

  -Distinguishes between different types of operating systems. 

  -Recognizes the internal parts of the computer in a tangible way 

 

 
 

 
 

 
 

  

 
 
 

 
  

4 

8 hours 
 
 

Chapter One(p1) 

 

 

Computer fundamentals 

 

 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions. 

6 

12 

hours 

Chapter two(p1) Computer's components 

 
lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter four(p1) operating systems lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 
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4 

8 hours Chapter One(p2) 

 

the Microsoft Word 
 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter three(p2) 

 

the Microsoft 
PowerPoint 
 

lectures, 

Computer, 

board 

,computer 

and pen. 

Report, 

Exams and 

discussions 

4 

8 hours  Print documents lectures, 

Computer, 

board 

,computer , 

printer and 

pen 

Report, 

Exams and 

discussions 

4 

8 hours  the Internet, 
networking, and email 
creation 

lectures, 

Computer, 

board ,net 

and pen. 

Report, 

Exams and 

discussions 



9  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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Course Description Form 
 

Course Name: 

         Computer 

Course Code: 

 

Semester / Year: 

5202/2024  

Description Preparation Date: 

18/9/2024 

5. Available Attendance Forms: 

Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

60 hours 

7. Course administrator's name (mention all, if more than one name) 
Name  Kholood Jamal Moulood 
Emil :  kjamal@tu.edu.iq  

 

 
• The student gets to know the concept of 
computer science 
• The student should be familiar with the 
personal computer 
• For the student to recognize the difference 
and relationship between software and the 
physical parts inside the computer 
• For the student to recognize the importance 
of using a computer 
• The student gets to know how the internal 
computer parts work 
• The student gets to know the concept of 
information that the computer deals with and 
its classification 
• The student will know how information 
enters and exits to and from the computer 
• The student gets to know some operating 
systems 
• The student gets to know the relationship 
between operating systems and hardware 
• That the student be able to maintain some 

mailto:kjamal@tu.edu.iq
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parts of the computer 
• For the student to learn about the benefits of 
the computer in his general life 
• The student will know how  used the 
Microsoft Word 
•The student will know how  used the 
Microsoft PowerPoint 
•The student will know how  used the printer 
to Print documents 
•The student will know how  used the Internet, 
networking, and email creation 
 
• That the student be able to know the internal 
parts of the computer in a concrete way 
• Introducing the student to concepts and 
strategies for computer operation 

 

 
To apply what he has learned for the purpose of solving many issues 

and problems in the same subject 

-Distinguishes how information enters and exits from and to the 

computer 

  -Distinguishes between different types of operating systems. 

  -Recognizes the internal parts of the computer in a tangible way 

 

 
 

 
 

 
 

  

 
 
 

 
  

4 

8 hours 
 
 

Chapter One(p1) 

 

 

Computer fundamentals 

 

 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions. 

6 

12 

hours 

Chapter two(p1) Computer's components 

 
lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter four(p1) operating systems lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 
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4 

8 hours Chapter One(p2) 

 

the Microsoft Word 
 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter three(p2) 

 

the Microsoft 
PowerPoint 
 

lectures, 

Computer, 

board 

,computer 

and pen. 

Report, 

Exams and 

discussions 

4 

8 hours  Print documents lectures, 

Computer, 

board 

,computer , 

printer and 

pen 

Report, 

Exams and 

discussions 

4 

8 hours  the Internet, 
networking, and email 
creation 

lectures, 

Computer, 

board ,net 

and pen. 

Report, 

Exams and 

discussions 



9  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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Course Description Form 
 

Course Name:  

Foundations of mathematics 

Course Code: 

 

Semester / Year: 2024-2025 

 

Description Preparation Date: 

18/9/2024 

5. Available Attendance Forms: 

 

6. Number of Credit Hours (Total) / Number of Units (Total) 

4 Hours  
  

7. Course administrator's name (mention all, if more than one name) 

Name : Hiba omar musa  

Emil :hom_34@tu.edu.iq  

Name: 
Email: 

 

 
- Study and know mathematical logic 
- Relationship concept relationships and application and 

its types 
- Study of numbers ,their origins. 

∙ 

∙ 

∙ 

 

 
Applying various teaching methods ,including  

- Giving lectures  
- Discussion method and electronic method 
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4-1 

 

12 Logic  The concept 

logic and  

mathematics 

proof   

Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 

8-5 12 The sets  algebraic 

operations  

Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 

12-9 12  Relations  Types of 

relations 

Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 

16-
13 

12 Mapping  Types of 

mapping  

Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 

20-
17 

12  Number capacity Number capacity Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 

25-
21 

15  Natural number , 

Integers number 

,Real number  and  

group 

their origins and 

group   

Electronic 

lectures, 

smart 

board ,pen   

Written and 

daily exams 

with 

assignments 
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Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 

 

                                                                                      Foundations of mathematics 

                                                                                      Foundations of mathematics            

                                                                                                      References  

                                                                                                       Shawm series   
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Course Description Form 
 

Course Name: 

         Computer 

Course Code: 

 

Semester / Year: 

5202/2024  

Description Preparation Date: 

18/9/2024 

5. Available Attendance Forms: 

Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

60 hours 

7. Course administrator's name (mention all, if more than one name) 
Name:fadya abdullfatah habeeb 
Email:fadya.habeeb@tu.edu.iq 

 

 
• The student gets to know the concept of 
computer science 
• The student should be familiar with the 
personal computer 
• For the student to recognize the difference 
and relationship between software and the 
physical parts inside the computer 
• For the student to recognize the importance 
of using a computer 
• The student gets to know how the internal 
computer parts work 
• The student gets to know the concept of 
information that the computer deals with and 
its classification 
• The student will know how information 
enters and exits to and from the computer 
• The student gets to know some operating 
systems 
• The student gets to know the relationship 
between operating systems and hardware 
• That the student be able to maintain some 
parts of the computer 
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• For the student to learn about the benefits of 
the computer in his general life 
• The student will know how  used the 
Microsoft Word 
•The student will know how  used the 
Microsoft PowerPoint 
•The student will know how  used the printer 
to Print documents 
•The student will know how  used the Internet, 
networking, and email creation 
 
• That the student be able to know the internal 
parts of the computer in a concrete way 
• Introducing the student to concepts and 
strategies for computer operation 

 

 
To apply what he has learned for the purpose of solving many issues 

and problems in the same subject 

-Distinguishes how information enters and exits from and to the 

computer 

  -Distinguishes between different types of operating systems. 

  -Recognizes the internal parts of the computer in a tangible way 

 

 
 

 
 

 
 

  

 
 
 

 
  

4 

8 hours 
 
 

Chapter One(p1) 

 

 

Computer fundamentals 

 

 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions. 

6 

12 

hours 

Chapter two(p1) Computer's components 

 
lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter four(p1) operating systems lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 
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4 

8 hours Chapter One(p2) 

 

the Microsoft Word 
 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter three(p2) 

 

the Microsoft 
PowerPoint 
 

lectures, 

Computer, 

board 

,computer 

and pen. 

Report, 

Exams and 

discussions 

4 

8 hours  Print documents lectures, 

Computer, 

board 

,computer , 

printer and 

pen 

Report, 

Exams and 

discussions 

4 

8 hours  the Internet, 
networking, and email 
creation 

lectures, 

Computer, 

board ,net 

and pen. 

Report, 

Exams and 

discussions 
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Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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1. Course name 

Educational psychology, first stage 

2. Course code 

 

3. Semester/year 

Year 2024-2025 

4. The date this description was prepared 

18/9/2024 

5. Available forms of attendance 

Attend my class + electronic class onGoogle Class Room will be a support class for the attendance class and according to the 

controls and instructions of the Ministry of Higher Education and Scientific Research. 

6. Number of study hours (total) / number of units (total) 

2 hours per week = 60 hours / units 2 units 

7. Name of the course administrator (if more 

Name:  M. M. Saood Rajab Hassan Email saood.r@tu.edu.iq  

From a name mentioned)  

 

8. Course objectives 

Objectives of the study subject 

 

 

 

 

 

 

The curriculum aims to prepare students to practice the teaching 

profession by learning about: 

1- Learn about educational psychology, style, motivation, and 

sensory perception. 

2- Learn about the types of educational psychology. 

3- How to formulate behavioral goals. 

4 - Knowledge of educational schools. 

5 - The importance of educational applications of learning 

theories. 

9. Teaching and learning strategies 

The strategy 

 

The standard method (giving lectures). 

1 - Lecture method. 

2 - The method of discussion and interrogation. 

3 –Brainstorming method. 

10. Course structure:The study began on 9/17/2023 and ends on 5/19/2024, the start date of final exams. 

the week hours Required learning 

outcomes 

Name of the unit or 

topic 

Learning method Evaluation 

method 

November 1 2  

Definition of 

educational 

psychology 

Lecture method 

Class 

performance 

and exams 

November 2 2  
Educational 

psychology stage 

Discussion and 

questioning 

Class 

performance 

and exams 
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November 3 

 
2  

Arab Islamic 

philosophy 

Discussion and 

questioning 

Class 

performance 

and exams 

November 4 2  Modern philosophy Brainstorming 

Class 

performance 

and exams 

December1 2  

Definition of 

psychology, its goals 

and importance 

Discussion and 

questioning 

Class 

performance 

and exams 

December2 2  Treads of psychology 
Discussion and 

questioning 

Class 

performance 

and exams 

December 3 

2 

 Branches of 

psychology 

Discussion and 

questioning 

Class 

performance 

and exams 

December4 

2 

 Applied direction Discussion and 

questioning 

Class 

performance 

and exams 

January1 

2 

 Behavior and the 

factors affecting it 

Discussion and 

questioning 

Class 

performance 

and exams 

January2 

2 

 The effect of genetics 

on behavior 

Problem Solving Class 

performance 

and exams 

January3 

2 

 Interaction between 

genetics and 

environment 

Discussion and 

questioning 

Class 

performance 

and exams 

January4 

2 

 Research methods in 

educational 

psychology 

Discussion and 

questioning 

Class 

performance 

and exams 

February1 

2 

 The importance of 

psychology in the 

educational process 

Discussion and 

questioning 

Class 

performance 

and exams 

February2 

2 

 Educational goals Discussion and 

questioning 

Class 

performance 

and exams 

February3 2  Spring break   

February4 

2 

 Factors affecting the 

teaching and learning 

process 

Discussion and 

questioning 

Class 

performance 

and exams 

March1 2  Attention and sensory Discussion and Class 
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perception questioning performance 

and exams 

March2 

2 

 Types of attention 

and factors affecting it 

Discussion and 

questioning 

Class 

performance 

and exams 

March3 

2 

 Sensory perception Discussion and 

questioning 

Class 

performance 

and exams 

March4 

2 

 Factors affecting 

sensory perception 

Discussion and 

questioning 

Class 

performance 

and exams 

April1 

2 

 Learning theories 

(conditional learning 

theory) 

Discussion and 

questioning 

Class 

performance 

and exams 

April2 

2 

 Clairvoyance theory Discussion and 

questioning 

Class 

performance 

and exams 

April3 

2 

 Transfer learning 

effect 

Discussion and 

questioning 

Class 

performance 

and exams 

April4 

2 

 Types of transition Discussion and 

questioning 

Class 

performance 

and exams 

May1 

2 

 How to benefit from 

transfer in the 

learning process 

Discussion and 

questioning 

Class 

performance 

and exams 

May2 

2 

 Feedback Discussion and 

questioning 

Class 

performance 

and exams 

May3 

2 

 Types of feedback Discussion and 

questioning 

Class 

performance 

and exams 

May4 2  review   

 

 

11. Course evaluation 

Distribution of the grade out of 100 according to the tasks assigned to the student, such as daily preparation, daily, oral, monthly, 

written exams, reports, etc. 

The degree is distributed through several channels: 

1- Formative (formative) assessment through daily exams, observing and following up on the student’s performance in 

class discussions and homework assignments, and classroom evaluation. Her grade does not exceed 20% of the total. 
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2- Diagnostic evaluation of the semester and final exams to issue judgments of success and failure. This grade is 80% and 

is divided into (4) exams, each semester with two exams, to extract the annual endeavor before entering the final exams. 

12. Learning and teaching resources 

Required textbooks (methodology, if any) Educational Psychology, written by Dr. Raouf Mahmoud Al-Qaisi. 

Main references (sources) 1 - Educational Psychology Dr. Fouad Abu Hatab. 

2 –Educational Psychology Dr.Rashid Marzouq Rashid. 

3 -Educational Psychology Dr. Hanaa Hussein Al-Felfali.  

Recommended supporting books and references 

(scientific journals, reports...) 

Access to everything that is current and published in peer-reviewed 

scientific journals 

Electronic references, Internet sites http://www.alkutubcafe.com/book/83rjar.html 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.alkutubcafe.com/book/83rjar.html
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Course Description Form 
 

Course Name:       

               Calculus 

Course Code:   

             Math.204 

Semester / Year:     

            2024-2025 

Description Preparation Date:   

            18/9 /2024 

5. Available Attendance Forms:  

              Actual presence/distance learning/recording video lessons 

6. Number of Credit Hours (Total) / Number of Units (Total) 

            5/140 

7. Course administrator's name (mention all, if more than one name) 

Name: Hiba Hani Abdullah   Email: hiba.h.a.83@tu.edu.iq 

 

 • Differentiation and integration are considered one of the main 
topics in mathematics, and the student usually studies the 
subject in several areas, including the topic of calculus of 
differentiation and integration, especially integration methods. 

 • Emphasis on studying the differentiation and integration of 
special functions, including trigonometric, hyperbolic, 
logarithmic, inverse, etc. 

 • .  Learn about several concepts in calculus 

 • Ensure knowledge of the applications and benefits of derivatives 

 

 
● Use explanation and clarification to present concepts. 

● Interact with students through discussions and practical exercises. 

● Use real-life  examples and applications to illustrate mathematical 

ideas. 

 



15  

Week Hours Required 

Learning 

Outcomes 

Unit or subject name Learning 

method 

Evaluation 

method 

2 10 Chapter one Real numbers - intervals - 

inequalities - functions - algebra of 

functions - finding the domain and 

range - complex function - drawing 

functions 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports 

2 10 The second 

and third 

chapter  

Limits and their properties - The 

method of finding the  limit - 

Theorems about limits - Infinite 

limits and limits at infinity - 

Continuity - Theories of continuity 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

4 20 Chapter 

four 

Derivation - Properties of 

differentiation - Derivation of the 

complex function - Chain law - 

Implicit derivative - Higher order 

derivatives - Rolle's theorem - Mean 

value theorem - Increasing and 

decreasing functions, maximum and 

minimum limits, points of 

concavity, convexity, and 

alignments 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

3 15 Chapter five Special functions (trigonometric 

functions, hyperbolic functions, 

logarithmic functions, and 

exponential functions) - drawing 

special functions - deriving special 

functions and finding their inverse 

functions 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

4 20 Chapter six Integration - indefinite integration - 

properties of integration - 

integration of functions 

(trigonometric - hyperbolic 

functions - exponential and 

logarithmic functions) 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  
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8 40 Chapter 

seven 

Integration methods Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

2 10 Chapter 

eight 

Applications to definite integration Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

1 5 Chapter 

ninth 

Infinite series - Naylor polynomial - 

Taylor and Maclaurin series 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

2 10 Chapter 

tenth 

Differential equations - the order of 

the equation and the solution of the 

differential equation - differential 

equations whose variables separate - 

the first-order and first-order 

complete differential equation 

Electronic 

lectures, 

smart 

board and 

pen 

Written 

exam with 

assignment

s and 

reports  

 
 

11. Course Evaluation  

Distribution of the grade out of 100 according to the tasks assigned to the 
student, such as daily preparation, daily, oral, monthly, written exams, reports, 
etc.: 
• Daily preparation. 
• Daily exams. 
• Oral and monthly tests. 
• Written tests. 
• Preparing reports and research projects. 
• Quarterly activities and participation in discussions. 
• Student performance in class and interaction with study materials 
 

 

12. Learning and Teaching Resources 

Required textbooks (curricular books, if 

any) 

Finney/Thomas  calculus  
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Main references (sources) Khaled Ahmed Al-Samarrai,, Calculus and 

Integration 

Recommended    books    and    

references (scientific journals, reports...) 

Thomas calculus 12th edition 

Electronic References, Websites 1-Encyclopedia of scientific books and journals, 

Tikrit University Journal of Pure Sciences 

and the Shome series 

 2- Reliable websites. 

 3- Virtual library. 

 4- Library locations in some international 

universities 

. 
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Course Name: Human Rights and Democracy - First Stage 

 

Course Code: 

 

Semester / Year: 2024 – 2025 

 

Description Preparation Date: 18/9/2024 

 

5. Available Attendance Forms: Classroom Lectures 
 

6. Number of Credit Hours (Total) / Number of Units (Total): 28 Hours / 1 Units  

 

7. Course administrator's name (mention all, if more than one name) 
Name: Assistant Lecture Elaf Hameed 
 Email: Elaf.mukhif@tu.edu.iq 

8. Course Objectives:  
1. Introducing the concept of rights and freedoms. 

2. Enhancing students' knowledge of rights from historical, legal, and international perspectives. 

3. Highlighting the importance of respecting freedoms and their role in societal advancement. 

4. Training students to apply rights and democracy concepts in real-life. 

9. Teaching & Learning Strategies 
Strategy Method 

Theoretical Methods Lecture Delivery 

Text-Based Method Textual Analysis 
 

 

 

 

 
 

10. Course Structure 

Week Hours 
Teaching 

Method 
Lesson Title 

Teaching 

Approach 

Assessment 

Method 
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November 

Week 2 
1  

Human Rights 

(Concept and 

Development) 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

November 

Week 3 
1  

Human Rights 

Violations 

during Wars 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

November 

Week 4 
1  

Human Rights 

in National 

and 

International 

Laws 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

December 

Week 1 
1  

Universal 

Declaration of 

Human Rights 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

December 

Week 2 
1  

Human Rights 

in the 2005 

Iraqi 

Constitution 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

December 

Week 3 
1  

Political and 

Economic 

Freedoms 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

December 

Week 4 
1  

Future of 

Human Rights 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

January 

Week 1 
1  

Children's 

Rights in 

Society 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

January 

Week 2 
1  

Women's 

Rights in 

Society 

Text-based 

method 

Practical 

Performance 

and 

Examinations 
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January 

Week 3 
1  

Types of 

Human Rights 

in Society 

(Part 1) 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

January 

Week 4 
1  

Types of 

Human Rights 

in Society 

(Part 2) 

Text-based 

method 

Practical 

Performance 

and 

Examinations 

    
Method of 

Instruction 
 

February / 

1 
1  

The Islamic 

perspective 

on human 

rights 

Standard 

Method / Text 

Method 

Classroom 

Performance 

and 

Examinations 

February / 

2 
1  

Freedom: 

Concept and 

its pillars 

Standard 

Method / Text 

Method 

Classroom 

Performance 

and 

Examinations 

February / 

3 
1 

Official holiday (7/7/2024     21/7/2024) 

 

February / 

4 
1  

Democracy/ 

Concept and 

Historical 

Roots 

Standard 

Method / Text 

Method 

classroom 

Performance 

and 

Examinations 

March / 1 1  
The social 

contract 

Standard 

Method / Text 

Method 

Classroom 

Performance 

and 

Examinations 

March / 2 1  
Images of 

democracy 
 

Standard 
Method / Text 

Method 

Classroom 
Performance 

and 
Examinations 

March / 3 1  
Electoral 

College 

Composition 

Electoral 

system/Voting 

systems 

Electoral 

System / 

Formation of 

the Electorate 
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Voting 

Systems 

March / 4 1  

Types of 

electoral 

systems 

Types of 

Electoral 

Systems 

Types of 

Electoral 

Systems 

April / 1 1  Civil society Civil society 
Political 

Parties 

April / 2 1  interest group interest group Civil Society 

April / 3 1  

Types of 

political 

regimes 

Types of 

political 

regimes 

Interest 

Groups 

April / 4 1  

Evaluation of 

Democracy / 

advantages 

Evaluation of 

Democracy / 

advantages 

Types of 

Political 

Systems 

May / 1 1  

Evaluation of 

Democracy / 

disadvantages 

Evaluation of 

Democracy / 

disadvantages 

Evaluation of 

Democracy / 

Advantages 

May / 2 1  

Problems of 

global 

democracy 

Electoral 

System / 

Formation of 

the Electorate 

Problems of 

Democracy 

May / 3 1 Final exams 

 
 

11.Course Evaluation  
The grade distribution is out of 100, covering tasks such as class attendance, oral exams, 
theoretical, practical exams, and reports. The grades are as follows: 
- 20 marks: Class interaction and evaluation during lectures 
- 30 marks: Attendance and participation in small group discussions and related activities 
- 50 marks: Final theoretical written exam 
- 1 mark: Final course report (if applicable) 
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2. References and Recommended Reading 

Category Details 

Printed Books and Sources - Dr. Mohammed Mahmoud, 'Islamic 

Perspective on Human Rights' 

- General Concept of Human Rights 

- Historical Development of Human 

Rights 

- Political Rights and Civil Rights 

- International Treaties Related to 

Human Rights 

- United Nations Charters 

Reports and Official Documents - 'UN Declaration of Human Rights' 

- Reports from International and 

Regional Conferences 

- Specific Legal Texts and Scientific 

Research 

Internet Resources Online academic platforms like Google 

Scholar, Academia.edu, and 

ResearchGate to search for credible 

academic papers and references. 
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Course Description Form 
 

Course Name:  Headway  for all Stages 

 

Course Code: ----------- 

 

Semester / Year: 2024-2025 

 

Description Preparation Date: 18/9/2024 

 

5. Available Attendance Forms: Class lectures 
 

6. Number of Credit Hours (Total) / Number of Units (Total): 60 hours / 14 Units 

 

7. Course administrator's name (mention all, if more than one name) 

Name:  Assist.Lect. Basma Faisal Ali 
Email: basma.faisal@tu.edu.iq 

 

 

1. Enabling the students to: 

 Read and write in English 

 Follow the basic rules of the 

English language. 

 Understand the ways of life in 

English-speaking societies, 

especially the British and 

American, and some of the 

differences between them. 

 Communicate linguistically.  

 Understand the language of films 

and the internet. 

2. Teaching the students English language in 

smooth and simple manner. 

3. Urging the students to solve the exercises 

and apply the rules. 

4. Encouraging them to continue learning 

mailto:basma.faisal@tu.edu.iq
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English language lessons by following 

programs in English and listening to 

conversation. 

5. Developing the Students’ skills in 

expressing himself and his ability to speak 

orally. 

6. Developing the students’ conversational 

skills and reading skills through the 

exercises in the student book 

 

 

 

 The standard method (giving lectures). 

 The text method. 

 Brainstorming method. 

 Some modern strategies. 

 

 

 
 

 
 

 

  

 
 

 

 
 

  
 

October  

1 

Unit  

One & Two 

1  1st Stage: 

Introduction use 

auxiliary /am/is/are 

In speaking and 

reading. 

Unit two: use the 

subjects 

/he/she/they/we/I/you 

In practice grammar.  

 

 

 

 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

 

 

 

 

Discussion and 

exam  

2nd Stage: 

Teaching tenses of 

English language 

  

3rd Stage: 

Introduction to 

auxiliary verbs 

 

4th Stage: 

Teaching zero 

condition 

 

October  

2 

Unit Three 

1  1st Stage: 

using negative and 

positive on short 

answers and 

 

 

 

Lecture 

 

 

 

Discussion and 
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2nd Stage: 

Teaching how to ask 

questions 

exam 

3rd Stage: 

Introduction to tenses 

and auxiliary verbs 

4th Stage: 

Teaching first and 

second condition of IF 

October  

3 

Unit Four 

1  1st Stage: 

Using possessives in 

adj. and plural nouns 

 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Teaching got /have got 

in every day 

conversation . 

 

3rd Stage: 

Teaching present 

simple 

4th Stage: 

Teaching tenses 

informal English 

spoken 

October  

4 

 Unit Five 

1  1st Stage: 

Teaching present 

simple 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Teaching how can 

identify sentences in 

present or past 

 

3rd Stage: 

Teaching short 

answers and auxiliary 

verbs 

4th Stage: 

Introduction to 

auxiliary verbs: 

be/do/have 

November 

1 

Unit Six 

1  1st Stage: 

Teaching past simple 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2nd Stage: 

Using much/many 

 

3rd Stage: 
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Teaching questions 

and auxiliary verbs 

Lecture Discussion and 

exam 

4th Stage: 

Introduction to full 

verbs 

 

 

November  

2 

Unit Seven 

1  1st Stage: 

Teaching present 

continuous 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Using countable  a 

few/a little of one 

syllable 

 

3rd Stage: 

Teaching the adverbs 

of present simple 

 

4th Stage: 

Teaching verbs of 

mind 

 

November  

3 

Unit Eight 

1  1st Stage: 

Teaching past 

continuous 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

The use of 

comparative and 

superlative 

3rd Stage:  

Teaching the adverbs 

of past simple 

 

4th Stage: 

Teaching verbs of 

mind 

November  

4 

Unit Nine 

1  1st Stage: 

Teaching past simple 

– irregular verbs 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Adding er to 

adjectives 

3rd Stage:  

Teaching the state 

verb of present 

continuous 
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4th Stage: 

Teaching verbs 

possession 

 

 

December  

1 

Unit Ten 

1  1st Stage: 

teach past simple in 

using questions and 

negatives 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Practicing of present 

perfect 

3rd Stage:  

Introduction to passive 

4th Stage: 

Teaching verbs certain 

other verbs 

December 

2 

Unit Eleven 

1  1st Stage: 

Using can in positive 

and negatives 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Teaching adverbs 

3rd Stage:  

Present simple and 

present continuous 

passives 

4th Stage: 

Teaching active and 

passive 

December  

3 

Unit Twelve 

1  1st Stage: 

Teaching model verbs 

 

 

 

 

Lecture 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Using word pairs 

3rd Stage:  

Teaching past perfect 

4th Stage: 

Teaching question 

forms 

December  

4 

Unit 

Thirteen 

1  1st Stage: 

Teaching adverbs 

 

 

 

 

Lecture 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Using short answers 

3rd Stage:  

Teaching past perfect 

in positives and 

negatives 

4th Stage: 

Asking for directions 
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January 

1 

Unit 

Fourteen 

1  1st Stage: 

using would like in 

questions 

 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

making plural with 

regular and irregular 

3rd Stage:  

Introduction to modal 

verbs 

4th Stage: 

Asking for 

descriptions 

January 

2 

1  1st Stage: 

Teaching some/any 

and the differences 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

How can use 

determiners in 

formulating questions 

and answers 

3rd Stage:  

The form of modal 

verbs 

4th Stage: 

Teaching direct 

questions 

January 

3 

1  1st Stage: 

Teaching like and 

would like 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Formulating positive 

and negative 

3rd Stage:  

Modal verbs in 

obligation and positive 

4th Stage: 

Using indirect 

questions 

January 

4 

1  1st Stage: 

Teaching like and 

would like 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Practicing two forms 

of present and past 

3rd Stage:  

modal verbs in 

affirmatives and 

negatives 
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4th Stage: 

Practicing possessives 

in different forms 

February 

1 

1  1st Stage: 

Teaching present 

simple and present 

continuous 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Practicing question 

words 

3rd Stage:  

Using should/ought 

to/must 

4th Stage: 

Forming negative 

questions 

February 

2 

1  1st Stage: 

Teaching Yes/No 

questions 

 

 

 

 

 

Lecture 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Practicing can/can’t 

3rd Stage:  

Modal verbs making 

request: 

can/could/will/would 

4th Stage: 

Using will for 

prediction 

March 

1 

1  1st Stage: 

Teaching future plans 

 

 

 

 

 

Lecture 

 

 

 

 

 

Oral Test 

2nd Stage: 

Practicing was/were 

3rd Stage:  

Modal verbs making 

offers: 

will/shall/should 

4th Stage: 

Using going to make 

prediction 

March 

2 

1  1st Stage: 

Teaching countable 

and uncountable 

 

 

 

 

 

Lecture 

 

 

 

 

 

Oral Test 

2nd Stage: 

Practicing /s'/ plural 

3rd Stage:  

Introduction to future 

forms 

4th Stage: 

Using will/going to for 

make decisions and 
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intentions 

March 

3 

1  1st Stage: 

Teaching the 

determiner the 

 

 

 

 

 

 

 

Lecture 

 

 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

How to indicate time 

3rd Stage:  

Introduction to present 

continuous in using 

will/going to 

 

4th Stage: 

using will and shall 

March 

4 

1  1st Stage: 

Teach the determiners 

a/an 

 

 

 

 

 

Lecture 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Negative short 

answers 

3rd Stage:  

Using will/going to 

4th Stage: 

Introduction to 

express quantities 

April 

1 

1  1st Stage: 

Teaching prepositions 

 

 

 

 

 

Lecture 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Using some/any, each 

/every, more/most 

3rd Stage:  

Introduction to like 

4th Stage: 

Introduction to modal 

verbs 

April 

2 

1  1st Stage: 

Teaching numbers 

 

 

 

 

 

Lecture 

 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

How to indicate place 

3rd Stage:  

The use of relative 

clauses 

4th Stage: 

Other uses to model 

verbs and related 

verbs 

April 

3 

1  1st Stage: 

Teaching collars 

 

 

 

 

Lecture 

 

 

 

 

Discussion and 

2nd Stage: 

Teach jobs 

3rd Stage:  
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The use of time 

clauses 

exam 

4th Stage: 

Introduction relative 

clauses 

April 

4 

1  1st Stage: 

Teaching question 

words 

 

 

 

 

Lecture 

 

 

 

 

Discussion and 

exam 

2nd Stage: 

Teach plural pronouns 

3rd Stage:  

The use of If 

conditions 

4th Stage: 

Expressing habits 

May 

1 

1  Revision for all the 

Stages 

 

Lecture 

Discussion and 

exam 

May 

2 

 
 

1  Revision for all the 

Stages 

 

Lecture 

Discussion and 

exam 

May 

3&4 

-------  Final Exams ----------------- ---------------- 

 

11.   Course Evaluation 

First Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Second Course: 

Monthly Exam: 20 

Daily homework: 5 

Total: 25 

Total for the 1st and 2nd Courses: 50 

Final Exam: 50 

Final Grade: 100 

12.   Learning and Teaching Sources 

Required textbooks (curricular books, if any) The Ministry’s prescribed book for all the stages 

Main references (sources) --------------------------------- 

Recommended books and references (scientific 

journal, reports 
 

Electronic References, Websites https://elt.oup.com/student/headway/beg/?cc=global
&selLanguage=en.  
https://elt.oup.com/student/headway/preint4/?cc=gl
obal&selLanguage=en.  
https://elt.oup.com/student/headway/int/?cc=global
&selLanguage=en.  
https://sc.nahrainuniv.edu.iq/lectures/7092_new-

https://elt.oup.com/student/headway/beg/?cc=global&selLanguage=en
https://elt.oup.com/student/headway/beg/?cc=global&selLanguage=en
https://elt.oup.com/student/headway/preint4/?cc=global&selLanguage=en
https://elt.oup.com/student/headway/preint4/?cc=global&selLanguage=en
https://elt.oup.com/student/headway/int/?cc=global&selLanguage=en
https://elt.oup.com/student/headway/int/?cc=global&selLanguage=en
https://sc.nahrainuniv.edu.iq/lectures/7092_new-headway-upper-intermediate-students-book.pdf
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headway-upper-intermediate-students-book.pdf.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sc.nahrainuniv.edu.iq/lectures/7092_new-headway-upper-intermediate-students-book.pdf
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Course Name:  

           Linear algebra   

Course Code: 

 

Semester / Year:  

         Academic Year (2024-2025) 

Description Preparation Date: 

9-18 -2024 

5. Available Attendance Forms: 

Weekly 
6. Number of Credit Hours (Total) / Number of Units (Total) 

         120 hours /  6 unit 

7. Course administrator's name (mention all, if more than one name) 
 

Name:   Assist . Lec . raghad wamedh faris 

  

  Email: rwamedh@tu.edu.iq     

 

 

- Introducing the basic characteristics of the nature of scientific material 

- Understanding the mathematical system and matrices and learning the types of -----

-matrices, operations on them, and their properties 

- Differential equations and methods for solving them 

- Study vector space and operations on vectors 

- Find the kernel and the image of the linear application 

- How to calculate distinct values, eigenvectors and polynomials 
 

 

 

 
- Use explanation and clarification to present concepts 

-  Interact with students through discussions and practical exercises 

- Use real-life examples and applications to illustrate mathematical ideas  

 

. 
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4 16 

 System of linear equation 

,matrices and operation on 

them  

 System of linear equation 

,matrices and operation on 

them  

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

4 16 

  Finding determinants and 

methods for solving linear 

equations 

  Finding determinants and 

methods for solving linear 

equations 

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

4 16 
Vectors in 2-spaces and 3-

spaces   
Vectors in 2-spaces and 3-

spaces   

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

3 12 Vector spaces and subspaces   
Vector spaces and 

subspaces   

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

2 8 Internal product spaces    Internal product spaces    

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

3 `2 Liner transformation  Liner transformation  Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

4 16 Eigenvalue and Eigenvector Eigenvalue and 

Eigenvector 

Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

4 16 Complex vector spaces  Complex vector spaces  Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 

3 12 Application  Application  Electronic lectures, 

smart board ,pens 

Written and daily 

exams with 

assignments 
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11.  Course Evaluation 
Distributing the score out of 100 according to the tasks assigned to the student such as 
daily preparation, daily oral, monthly, or written exams, reports… 

 

 

12. Learning and Teaching Resources  
Required textbooks (curricular books, if any) 

 
 

   . Daige, L. S Wift, J and Slobko, T; 
Elements of Linear Algebra, XEROX. 

 1974 

 

Main references (sources)     S rang. G; Linear Algebra and its 
Applications, A cademic Press, 1976ا  

Recommended books and references (scientific 
journals, reports...) 

•   Lang S; Linear Algebra, Addison Wesley 
Publishing Co., 1973.  

Electronic References, Websites  
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Course Description Form 
 

Course Name: 

physics 

Course Code: 

 

Semester / Year: 
2024-2025 

Description Preparation Date: 
18/9/2024 

5. Available Attendance Forms: 
 

6. Number of Credit Hours (Total) / Number of Units (Total) 
66 hour/ 2 units 

7. Course administrator's name (mention all, if more than one name) 
Name :  SarwaA.Mohammed 
Emil :  srwa.muhammed@tu.edu.iq  

 

Course Objectives 

 
 

 -Learn about the basics of general physics 

-The student acquires information about 

natural phenomena. 

 

 • -Applying various teaching methods ,including  

-Giving lectures  

-Discussion method and electronic method. 

 

 

 
  

  

 

  
 

1-4 

 

 

 

12 
Physical quantities and 

motion 

Scalar, vector, and 
motion quantities Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

 

mailto:srwa.muhammed@tu.edu.iq
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5-8 8 
Knowledge of the laws of 

motion and its types 

Circular motion 

and rotational 

motion 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

 

9-12 8 Discovering the 

relationship between 

work, energy, capacity 

and the importance of 

flexibility 

Work, energy, 

capacity and 

elasticity 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

13-16 8 Identifying the laws of 

attraction and their 

importance for 

maintaining cosmic 

balance, the importance 

of harmonic motion, and 

the importance of their 

applications 

Gravitational 

attraction harmonic 

motion 

Electronic   

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework and 

reports 

17-20 8 Identify vibration and its 

importance 

 

 

 

Vibration of strings 

and air columns Electronic 

lectures, lecture 

method, smart 

board and pen 

Exams with 

homework 

and reports 

21-25 12 Learn about the 

importance of Newton's 

law 

Newton's laws of 

motion 

Electronic 

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework 

and reports 

26-30 12 Heat and its common 

methods of transmission 

the heat Electronic 

lectures, lecture 

method, smart 

board and pen 

 

Exams with 

homework 

and reports 

 
Distributingthescoreoutof100accordingtothetasksassignedtothestudentsuchasdaily 
preparation, daily oral, monthly, or written exams, reports 

 

 
1-University Physics, Part One: Mechanics, 

properties of matter, wave motion, and heat, written 

by Dr. Talib Nahi Al-Khafaji. Dr. Fayyad Abdel Latif 

Al-Najm. 
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• 2-University Physics, Part Two, written by Dr. 

Talib Nahi Al-Khafaji and Dr. Fayyad Abdul Latif 

Al-Najm 

 - Physics theories Friedrich Bosch David Gerd 

 

Encyclopedia of scientific books and journals 

 
Electronic references, Internet sites 
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Course Description Form 

1. Course name: 

Developmental psychology  

2. Resolution code 
 

3. Semester/year 

2024 - 2025 

4. The date this description was prepared 

18/9/2024 

5. Available forms of attendance 

Class lectures 

6. Number of study hours (total) 

60 hours. Number of units (total) 4 

7. Name of the course administrator 

Teacher: Ghaleb Mahmoud Mahoos                                        gMahmod@tu.edu.iq 

8. Course objectives 

1- Providing female students with science and knowledge related 

to human development at different age stages from birth to old age. 

2-  Introducing and training female students on the methods and 

requirements of age stages (childhood - adolescence - adulthood - 

old age). 

3- Preparing a generation of college graduates to teach in the 

middle and secondary levels. 

4- Providing female students with education and knowledge to 

meet the requirements of life and its development. 

Objectives of the study 

subject 

9. Teaching and learning strategies 

mailto:gMahmod@tu.edu.iq
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11. Course evaluation 

50 marks for the annual endeavor, 25 marks for each semester, divided as follows: 

20 marks for the written exam 

5 marks per day, distributed among daily exams or reports 

50 marks for end-of-year exam 

12. Learning and teaching resources 

The prescribed materials are from various 
books related to developmental psychology 

1- Required prescribed books 

1- Psychology of childhood and adolescence / 
Jamal Al-Alusi and Omaima Ali Khan 

2- Main references (sources) 

2- Evolutionary Psychology / Sami Arifaj 
 

A- Recommended books and 
references (scientific journals, 

reports,...) 
3- Basics of evolutionary psychology/Shafiq 

Hassan 
B - Electronic references, Internet 

sites... 
 

 

 

 

 

 

 

- The standard method (giving lectures). 

- Text method. Discussion method Strategy 

 

13. Course outcomes and teaching, learning and evaluation methods 
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A- Cognitive objectives: 

1 - Understanding and interpreting behavior 

2 - Predicting what the behavior will be like 

3 - Controlling, controlling, modifying, modifying and improving behavior 

B- The skills objectives of the course: 

1- Developmental psychology helps to understand the foundations and the factors that 

influence them of psychological processes, the stages of their development. 

2- . Through developmental psychology, we can know normal appropriate behavior. 

3- can know progress and delay in development.. 

C-  Emotional and value goals: 

1- Access to complete knowledge about the nature of individuals. 

2- Forming desires and behavior patterns to understand their personalities and what they are 

affected by. 

3- Knowing the genetic and environmental factors affecting growth. 

D - Transferable general and qualifying skills (other skills related to employability and personal 
development). 

14- Course development plan 

Developing the academic material according to the annual plan to update the academic 
programs approved in the college, through workshops, seminars, and conferences, and 

benefiting from their recommendations. 
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Curriculum skills chart 

Please check the boxes corresponding to the individual learning outcomes from the program being assessed 

 Learning outcomes required from the programme 

Year/le
vel 

Course 
code 

Course 
name 

essential 
Or optional 

Cognitive 
objectives 

Skills objectives 
of the 

programme 

Emotional and 
value goals 

General and 
qualifying 

transferable skills 
(other skills 

related to 
employability and 

personal 
development) 

0أ 2أ  3أ  4أ  0ب  2ب  3ب  4ب  0ج  2ج  3ج  4ج  0د  2د  3د  4د   

the first  Principles 
of 

education 

essential X X X X X X X X X X X X X X X X 
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 Course Description 

Form 
 

Course Name: 

         Computer 

Course Code: 

 

Semester / Year: 

5202/2024  

Description Preparation Date: 

18/9/2024 

5. Available Attendance Forms: 

Classroom and Google classroom 

6. Number of Credit Hours (Total) / Number of Units (Total) 

60 hours 

7. Course administrator's name (mention all, if more than one name) 
Name :  Assist. Prof. Dr Israa Munir Tawfik 

Emil :   

 

 
• The student gets to know the concept of 
computer science 
• The student should be familiar with the 
personal computer 
• For the student to recognize the difference 
and relationship between software and the 
physical parts inside the computer 
• For the student to recognize the importance 
of using a computer 
• The student gets to know how the internal 
computer parts work 
• The student gets to know the concept of 
information that the computer deals with and 
its classification 
• The student will know how information 
enters and exits to and from the computer 
• The student gets to know some operating 
systems 
• The student gets to know the relationship 
between operating systems and hardware 
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• That the student be able to maintain some 
parts of the computer 
• For the student to learn about the benefits of 
the computer in his general life 
• The student will know how  used the 
Microsoft Word 
•The student will know how  used the 
Microsoft PowerPoint 
•The student will know how  used the printer 
to Print documents 
•The student will know how  used the Internet, 
networking, and email creation 
 
• That the student be able to know the internal 
parts of the computer in a concrete way 
• Introducing the student to concepts and 
strategies for computer operation 

 

 
To apply what he has learned for the purpose of solving many issues 

and problems in the same subject 

-Distinguishes how information enters and exits from and to the 

computer 

  -Distinguishes between different types of operating systems. 

  -Recognizes the internal parts of the computer in a tangible way 

 

 
 

 
 

 
 

  

 
 
 

 
  

4 

8 hours 
 
 

Chapter One(p1) 

 

 

Computer fundamentals 

 

 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions. 

6 

12 

hours 

Chapter two(p1) Computer's components 

 
lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 
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4 

8 hours Chapter four(p1) operating systems lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter One(p2) 

 

the Microsoft Word 
 

lectures, 

Computer, 

board and 

pen. 

Report, 

Exams and 

discussions 

4 

8 hours Chapter three(p2) 

 

the Microsoft 
PowerPoint 
 

lectures, 

Computer, 

board 

,computer 

and pen. 

Report, 

Exams and 

discussions 

4 

8 hours  Print documents lectures, 

Computer, 

board 

,computer , 

printer and 

pen 

Report, 

Exams and 

discussions 

4 

8 hours  the Internet, 
networking, and email 
creation 

lectures, 

Computer, 

board ,net 

and pen. 

Report, 

Exams and 

discussions 
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Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports ..... etc 
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